4.5.4 MICROPHONE CONTROL ..............................................................44
4.5.5 HARDWARE CONTROLS SUBMENU ........................................45
4.5.6 SAMPLING FREQUENCY ................................................................46
4.5.7 TEMPERATURE ........................................................................46
4.6 QCBOX & PORTS CONTROLS .........................................................47
4.6.1 DEDICATED CONTROL OF THE PARALLEL PORT ....................47
4.6.1 DEDICATED CONTROL OF THE QCBOX MODEL 5 .......................48
4.7 CONTROLLING TURNTABLES .......................................................49
4.7.1 TURNTABLES OPTIONS DIALOG .............................................51
4.8 BASIC CONNECTIONS ..................................................................55
4.8.1 CONNECTING THE CLIO BOX ..................................................55
4.8.2 CONNECTING A MICROPHONE ...............................................57
4.8.3 CONNECTING THE CLIOQC AMPLIFIER & SWITCHBOX ..........58

5 SYSTEM OPERATIONS AND SETTINGS ........................................61

5.1 INTRODUCTION ..........................................................................61
5.2 REGISTERED FILE EXTENSIONS .................................................61
5.3 FILE SUBMENU ..........................................................................63
  5.3.1 LOADING AND SAVING FILES .............................................63
  5.3.2 AUTOSAVE SETTINGS ..........................................................65
  5.3.3 EXPORTING ASCII DATA ....................................................67
  5.3.4 EXPORTING GRAPHICS .......................................................67
  5.3.5 NOTES ABOUT MEASUREMENT ...........................................68
  5.3.6 PRINTING .............................................................................68
5.4 CLIO OPTIONS .............................................................................69
  5.4.1 GENERAL .............................................................................69
  5.4.2 UNITS CONVERSION ...........................................................70
  5.4.3 GRAPHICS ...........................................................................73
  5.4.4 HARDWARE ..........................................................73
5.5 DESKTOP MANAGEMENT ............................................................74
5.6 STARTUP OPTIONS AND GLOBAL SETTINGS .........................75
  5.6.1 SAVING MEASUREMENT SETTINGS ...................................75

6 COMMON MEASUREMENT INTERFACE .....................................77

6.1 INTRODUCTION ..........................................................................77
6.2 UNDERSTANDING THE DISPLAY IN FRONT OF YOU ..................77
  6.2.1 STEREO MEASUREMENTS DISPLAY ..................................78
  6.2.2 COLLAPSING MARKERS ......................................................79
  6.2.3 DIRECT Y SCALES INPUT ...................................................79
6.3 BUTTONS AND CHECKBOXES .....................................................80
6.4 HOW TO ZOOM ..........................................................................81
6.5 SHORTCUTS AND MOUSE ACTIONS .........................................81
6.6 THE MLS TIME DOMAIN DISPLAY ..........................................82

7 SIGNAL GENERATOR .................................................................83

7.1 INTRODUCTION ..........................................................................83
7.2 SINUSOID ..................................................................................83
7.3 TWO SINUSOIDS .......................................................................85
7.4 CEA BURST ...............................................................................86
7.5 MULTITONES .............................................................................87
7.6 WHITE NOISE ...........................................................................88
7.7 MLS ............................................................................................89
7.8 CHIRPS ........................................................................................................... 90
7.9 PINK NOISE ..................................................................................................... 92
7.10 ALL TONES ...................................................................................................... 94
7.11 SIGNAL FILES ............................................................................................... 96
7.11.1 SAVING SIGNAL FILES ............................................................................ 97
7.12 THE GENERATOR CONTROL PANEL .......................................................... 98

8 MULTI-METER ................................................................................................. 101
  8.1 INTRODUCTION .......................................................................................... 101
  8.2 MULTI-METER CONTROL PANEL .............................................................. 101
   8.2.1 TOOLBAR BUTTONS ............................................................................. 102
  8.3 LCR METER ................................................................................................. 106
  8.4 INTERACTION BETWEEN THE MULTI-METER AND FFT ......................... 107
  8.5 MULTI-METER SHORTCUTS ...................................................................... 107
  8.6 MULTI-METER FILE TYPES ...................................................................... 107

9 FFT, RTA AND “LIVE” TRANSFER FUNCTION .............................................. 109
  9.1 INTRODUCTION .......................................................................................... 109
  9.2 FFT ANALYZER CONTROL PANEL ............................................................ 109
   9.2.1 TOOLBAR BUTTONS ............................................................................. 110
  9.3 FFT SETTINGS ............................................................................................ 114
   9.3.1 DEDICATED ’LIVE’ SETTINGS AND TOOLBAR FUNCTIONS ............. 115
  9.4 FFT AND MULTI-METER ............................................................................ 116
  9.5 FFT AND Leq ANALYZER ......................................................................... 116
  9.6 FFT SHORTCUTS ....................................................................................... 117
  9.7 FFT FILE TYPES ....................................................................................... 117
  9.8 FFT ASCII TEXT EXPORT ........................................................................ 117

10 MLS & LOG CHIRP ......................................................................................... 119
  10.1 INTRODUCTION ....................................................................................... 119
  10.2 MLS & LOG CHIRP CONTROL PANEL ...................................................... 120
   10.2.1 TOOLBAR BUTTONS .......................................................................... 120
  10.3 MLS & LOG CHIRP SETTINGS .................................................................... 123
  10.4 IMPULSE RESPONSE CONTROL PANEL ................................................ 124
  10.5 MLS & LOG CHIRP POST-PROCESSING TOOLS ....................................... 125
  10.6 MLS & LOG CHIRP SHORTCUTS .............................................................. 126
  10.7 MLS & LOG CHIRP FILE TYPES ............................................................... 126
  10.8 MLS & LOG CHIRP ASCII TEXT EXPORT .............................................. 126

11 SINUSOIDAL ..................................................................................................... 127
  11.1 INTRODUCTION ....................................................................................... 127
  11.2 SINUSOIDAL CONTROL PANEL ............................................................... 127
   11.2.1 TOOLBAR BUTTONS .......................................................................... 127
   11.2.2 SINUSOIDAL SETTINGS DIALOG ......................................................... 130
  11.3 SINUSOIDAL POST PROCESSING TOOLS ................................................ 132
  11.4 SINUSOIDAL SHORTCUTS ...................................................................... 133
  11.5 SINUSOIDAL FILE TYPES ........................................................................ 133
  11.6 SINUSOIDAL ASCII TEXT EXPORT ....................................................... 133

12 DIRECTIVITY & 3D BALLOON ........................................................................ 135
1 INTRODUCTION

1.1 ABOUT THIS MANUAL

This User's Manual explains the CLIO system hardware and CLIO 12 software.

All software versions are covered, please note that CLIO 12 software is designed to operate in conjunction with the supplied PC hardware. If the hardware is absent or the serial numbers do not correspond then CLIO 12 will operate in demo mode only.

1.1.1 WHAT THIS USER MANUAL DOES COVER

The CLIO System is a complete electro-acoustic analyzer. There are thousands of books on many of the topics that CLIO handles as a measurement system. The simple definition of Frequency Response could be extended to a book itself. This User Manual is intended only as a guide to allow the user to quickly become efficient in using the CLIO system, its user interface, its hardware features and limits.

There is an important reference [1], 'Testing Loudspeakers' by Joseph D'Appolito, which, in our opinion, is the perfect complement of what is covered here. Anyone who feels that WHY and HOW is strongly related should seriously consider buying this wonderful book.

1.2 GENERAL CONDITIONS AND WARRANTY

THANKS

Thank you for purchasing your CLIO system. We hope that your experiences using CLIO will be both productive and satisfying.

CUSTOMER SUPPORT

Audiomatica is committed to supporting the use of the CLIO system, and to that end, offers direct support to end users. Our users all around the world can contact us directly regarding technical problems, bug reports, or suggestions for future software enhancements. You can call, fax or write to us at:

Audiomatica SRL
VIA MANFREDI 12
50136 FLORENCE, ITALY
PHONE: +39-055-6599036
FAX: +39-055-6503772

AUDIOMATICA ON-LINE

For any inquiry and to know the latest news about CLIO and other Audiomatica’s products we are on the Internet to help you:

AUDIOMATICA website: www.audiomatica.com
E-MAIL: support@audiomatica.com
Audiomatica warrants the CLIO system against physical defects for a period of one year following the original retail purchase of this product. In the first instance, please contact your local dealer in case of service needs. You can also contact us directly as outlined above, or refer to other qualified personnel.

WARNINGS AND LIMITATIONS OF LIABILITY

Audiomatica will not assume liability for damage or injury due to user servicing or misuse of our product. Audiomatica will not extend warranty coverage for damage of the CLIO system caused by misuse or physical damage. Audiomatica will not assume liability for the recovery of lost programs or data. The user must assume responsibility for the quality, performance and the fitness of Audiomatica software and hardware for use in professional production activities.

The CLIO SYSTEM, CLIOfw, CLIOQC and AUDIOMATICA are registered trademarks of Audiomatica SRL.
REGISTRATION CARD

**AUDIOMA**  
*(EMAIL OR FAX TO US)*

CLIO SERIAL NUMBER: ____________________________

SOFTWARE VERSION: ____________________________

PURCHASE DATE: ______________________________

NAME: _______________________________________

JOB TITLE: _________________________________

COMPANY: __________________________________

ADDRESS: __________________________________

ZIP OR POST CODE: ___________________________

PHONE NUMBER: _____________________________

FAX NUMBER: _______________________________

E-MAIL: _____________________________________
Depending on the hardware options that have been purchased, the CLIO system consists of the following components:

- The FW-02 USB interface
- The MIC-01 or MIC-02 or MIC-03 or MIC-04 microphones
- The PRE-01 microphone preamplifier
- The QCBox Model 5 power amplifier, switching and testing box

In the next few pages we will describe each component and give its respective technical specifications.

NOTE: Audiomatica reserves the right to modify the following specifications without notice.
2.1 THE FW-02 USB INTERFACE

The FW-02 USB Interface sets new hardware precision standards for the CLIO System. The FW-02 unit has been designed to be a complete two channels professional A/D D/A audio front-end for your PC; it is connected to the computer using a USB 2.0 port giving you maximum performances. The FW-02 performances (24 bit @ 192 kHz) represent state-of-the-art measurement capabilities for any audio device or acoustical test. The FW-02 is equipped with an instrument grade balanced input and output analog circuitry with an exceptionally wide range of output attenuation and input gain that allows an easy interface to the outer world; the input and output loopback capability with the internal ultra stable voltage reference permit a simple and precise calibration of the whole instrument. A switchable phantom power supply lets you directly connect an Audiomatica MIC-01, MIC-02, MIC-03 or MIC-04 as well as any other standard balanced microphone to any of the FW-02 input.

2.1.1 TECHNICAL SPECIFICATIONS

GENERATOR
Two channels 24 Bit sigma-delta D/A Converter
Frequency range: 1Hz-90kHz
Frequency accuracy: >0.01%
Frequency resolution: 0.01Hz
Output impedance: 660Ohm
Max output level (Sine):17dBu (5.5Vrms)
Attenuation: 0.1 dB steps to full mute
THD+Noise(Sine):0.008%
Digital out: SPDIF

ANALYZER
Two channels 24 bit sigma-delta A/D Converter
Input range: +40 ÷ -40dBV
Max input acceptance: +40dBV (283Vpp)
Input impedance: 128kOhm (5.6kOhm mic)
Phantom power supply: 24V

PC SYSTEM RESOURCES
One free USB 2.0 port

MISCELLANEOUS
Sampling frequencies: 192kHz, 96kHz and 48kHz.
Connections: analog 2 XLR combo in, 2 XLR plus 2 RCA out, 1 RCA digital out
Digital connection: USB type B
Power supply: External 12V DC (AC adapter supplied)
Dimensions :16(w)x17(d)x4(h)
Weight: 0.8 kg
2.2 THE MIC-01, MIC-02 AND MIC-03 MICROPHONES

2.2.1 THE MIC-01 MICROPHONE

The MIC-01 microphone is an electret measuring microphone that is particularly well suited to being used in conjunction with the other components of the CLIO system. It is furnished with a 2.7m cable, a stand adapter, a 1/2” calibrator adapter and a calibration chart reporting the individually measured sensitivity, all fitted in an elegant plastic case. Its long and thin shape renders it ideal for anechoic measurements. Because its frequency response is very flat over the entire audio band, no particular correction is usually needed.

2.2.2 THE MIC-02 MICROPHONE

The MIC-02 microphone is functionally identical to MIC-01. It differs only in the fact that its length is 12 cm instead 25 cm. The MIC-02 is more practical to handle and to work with, and is ideal for measurements in a reverberant environment.

2.2.3 THE MIC-03 MICROPHONE

The MIC-03 microphone is functionally identical to MIC-01. It differs only in the fact that its length is 7 cm instead 25 cm. The MIC-03 is more convenient where space saving is a must.
2.2.4 TECHNICAL SPECIFICATIONS

MIC-01
Type: Condenser electret
Accuracy: ±1 dB, 20 Hz to 10 kHz
          ±2 dB, 10 kHz to 20 kHz (direct field)
Maximum level: 130 dB SPL
Dimensions: 8 mm diameter, 25 cm long
Accessories: case, 2.7 m cable, stand adapter, 1/2” calibrator adapter

MIC-02: Same as MIC-01, but 12 cm long.
MIC-03: Same as MIC-01, but 7 cm long.

Polar Response:

2.2.5 THE MIC-01 (OR MIC-02) FREQUENCY CALIBRATION DATA

The microphones MIC-01 and MIC-02 can be furnished, at a separate cost, with a frequency calibration certificate. This document, along with numerical data on disk, is released by Audiomatica and specifies the frequency behavior of the single microphone under test. The data can be used with the CLIO software (5.4.2).

2.2.6 THE MIC-04 MICROPHONE

It is possible to get the same characteristics of our range of microphones in a particular housing, rugged and space savings, for production line QC application.
The microphone preamplifier PRE-01 has been designed to match Audiomatica’s microphones MIC-01, MIC-02, MIC-03 or MIC-04. It is particularly useful when the microphone has to be operated far from the analyzer or when weighted measurements are needed. PRE-01 powers the microphone connected to its input with an 8.2V phantom supply and adds a selectable weighting filter (A or B or C); also available there is a 20 dB gain stage. The unit is operated with one standard 9V battery or with an external DC power supply.

### 2.3.1 TECHNICAL SPECIFICATION

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency response</td>
<td>7Hz÷110kHz (-3dB)</td>
</tr>
<tr>
<td>Weighting filter</td>
<td>A, B, C (IEC 651 - TYPE I)</td>
</tr>
<tr>
<td>Phantom power supply</td>
<td>8.2V (5600 Ohm)</td>
</tr>
<tr>
<td>Gain</td>
<td>0 &amp; 20dB (INTERNAL SETTINGS)</td>
</tr>
<tr>
<td>Input impedance</td>
<td>5600 Ohm</td>
</tr>
<tr>
<td>Output impedance</td>
<td>100 Ohm</td>
</tr>
<tr>
<td>Maximum output voltage (@1kHz)</td>
<td>25 Vpp</td>
</tr>
<tr>
<td>THD (@1kHz)</td>
<td>0.01%</td>
</tr>
<tr>
<td>Input noise (@20dB gain)</td>
<td>7uV LIN, 5.3uV A</td>
</tr>
<tr>
<td>Drive capability</td>
<td>±7mA</td>
</tr>
<tr>
<td>Batteries duration</td>
<td>&gt;24h (alkaline cell)</td>
</tr>
<tr>
<td>Size</td>
<td>12.5(w)x19(d)x5(h)cm</td>
</tr>
<tr>
<td>Weight</td>
<td>900g</td>
</tr>
</tbody>
</table>

### 2.3.2 USE OF THE PREAMPLIFIER

The MIC-01 or MIC-02 or MIC-03 or MIC-04 microphone cable should be connected to the preamplifier input while the preamplifier output requires connection to the analyzer input. The unit is switched on with the POWER switch, while the TEST push-button controls the state of the unit. Correct operation of the unit is indicated by the led light being illuminated, if the LED fails to illuminate then either the batteries are low or the external power supply is not connected. The FILTER switch inserts the weighting filter. To choose the desired weighting filter type and to set the amplifier gain you have to modify the unit settings with the dip switch operated from the back panel.

**NOTE:** if the 20 dB gain stage is inserted the overall sensitivity (microphone + pre) is 10 times higher. For example if your microphone has a sensitivity of 17.1 mV/Pa and you amplify it by 20 dB then you get a sensitivity of 171 mV/Pa.
The QCBOX Model 5 power amplifier, switching and testing box is of invaluable help when configuring an automatic or manual quality control setup, or even in everyday laboratory use.

It can be configured, under software control via USB, to assist frequency response and impedance measurements or to perform DC measurements.

Between its features is the possibility of internal switching that permits the measurement of the impedance and frequency response of the loudspeaker connected to its output sockets without changing the wiring to the speaker; it is also possible to route one of four inputs for the response measurements; these input have powering for a microphone (0÷24V variable).

An internal ADC measures the DC current into the voice coil; an over current limiter is available to a predefined threshold. Thanks to an internal software controlled voltage generator the speaker can be driven with a superimposed DC voltage (±20V max), allowing for measurements of large signal T&S parameters. Two ADC converters with a ±2.5V and ±5V are available at inputs 3 and 4 to measure the displacement with a laser sensor or any other DC signal.

A dedicated output, ISENSE, allows impedance measurements in constant voltage mode as well as voice coil current distortion analysis.

A 5 bit in - 6 bit out digital port is available to interface the QCBOX with external hardware or line automation. An ulterior dedicated input permits an external foot pedal switch to be connected and trigger QC operations.
MECHANICAL ASSEMBLIES
19” RACK MOUNT ASSEMBLY
Using the Rack QC panel it is possible to assemble the QCBOX Model 5 together the FW-02 Audio Interface so that they can be mounted in a standard 19” rack frame.

FW PANEL MOUNT ASSEMBLY
Using the FW panel it is possible to assemble the QCBOX Model 5 together the FW-02 Audio Interface in a convenient way for laboratory use.

2.4.1 TECHNICAL SPECIFICATIONS

Inputs:
- Four line/microphone inputs with selectable phantom power supply (0÷24V variable)
- One TTL input for external trigger
- 5 digital lines

Outputs:
- Isense
- 6 digital lines

Functions:
- USB controlled internal switches for impedance and DC measurements
- DC measuring:
  - Isense current ±2.25 A
  - DC IN 3 ±2.5 V
  - DC IN 4 ±5 V

Power output stage:
- 50W (8Ohm) with current sensing and overcurrent protection
  - Possibility of superimposing a DC voltage (±20 V)

THD (@1 kHz):
- 0.004 %

Dimensions:
- 23(w)x23(d)x4(h)cm

Weight:
- 1.4kg

AC:
- 90÷240V
3 CLIO INSTALLATION

3.1 MINIMUM PC CONFIGURATION

The CLIO FW-02 USB interface running the CLIO 12 software can be installed in any personal computer with the following minimum system requirements:
- Processor: single-core @ 2GHz clock or dual-core (suggested)
- One free USB 2.0 port
- 1024x786 video adapter
- Microsoft Windows XP, Vista, 7, 8 or 10

BE SURE TO HAVE ADMINISTRATIVE RIGHTS WHEN INSTALLING!

3.2 FW-02 DRIVERS INSTALLATION

To install the FW-02 drivers in your computer you should follow the instructions presented below:

1) Connect the FW-02 to a free USB 2.0 port on your PC and power it with its 12V supply. You should hear the classical sound of plug and play devices.

NOTE: ClioXP is the nickname of the FW-02 device seen by Windows.

2) After the initial automatic driver detection only one device should be found and properly installed by Windows, the USB Composite Device; two more devices, named ClioXP will need to be installed manually. Open Device Manager (type devmgmt.msc from Run prompt or click Control Panel>System>Device Manager); you should find this situation:
3) Insert the CLIO 12 installation CD-ROM in the PC.

4) Right-Click on each ClioXP device under Other Devices and choose Update Driver Software. At the successive prompt:

5) Browse your computer and point to the folder inside the installation CD where the proper drivers are located (for example \Driver\10).
Ignore any Microsoft's warning message about Digital Signature or Publisher and reach the end of the wizard.

6) Inspecting again the Device manager confirms you the proper ClioXP Control and ClioXP Stream entries under USB controllers category:
Your driver installation was successful!

3.3 FW-02 DRIVERS INSTALLATION UNDER WINDOWS XP

1) Connect the FW-02 to a free USB 2.0 port on your PC and power it with its 12V supply. You should hear the classical sound of plug and play devices. **NOTE:** ClioXP is the nickname of the FW-02 device seen by Windows.

2) The Found New Hardware Wizard detects the CLIO XP device:

As the CLIOXP drivers are unknown to Windows you will be prompted with this search window:
3) Insert the CLIO 12 installation CD-ROM in the PC. Search in the proper CD folder (for example Drivers\XP)

5) Do not stop to Microsoft Warning about Windows Logo testing.
6) Open Device Manager (type `devmgmt.msc` from Run prompt or click Control Panel>System>Device Manager); you should find this situation:

![Device Manager screenshot]

Your driver installation was successful!

### 3.5 SOFTWARE INSTALLATION

This paragraph deals with software installation.

**Be sure to have administrative rights when installing CLIO.**

The CLIO software is provided either on its own CD-ROM, SD card or, in electronic
format, as a single, self-extracting, executable file.

To install the CLIO 12 software in your computer you should follow the instructions presented below:

1) Insert the CLIO 12 CD ROM in the computer.

3) Choose CLIO 12 installer to start installation.

The procedure is completely automatic and will only request you to accept the Software End User's License Agreement and input some information in order to correctly install CLIO 12; the software installer will also check your operating system version.

After successfully completing this procedure take note of the installation directory of CLIO (usually C:\Program Files\Audiomatica\CLIO12 or C:\Program Files (x86)\Audiomatica\CLIO12 ).
3.6 RUNNING CLIO FOR THE FIRST TIME

If you have completed the preceding installation procedure, you are ready to run CLIO!

3.6.1 THE 'CLIO BOX' AND CLIO SERIAL NUMBER

A few words about the FW-02 USB interface.

This unit is needed to correctly interface analog signals to your PC; it is also important as it has an internal reference used to calibrate the system and also stores the system's serial number inside its internal EEPROM; Figure below shows where is located your CLIO system serial number.

The CLIO serial number is very important and should be mentioned each time you get in contact with Audiomatica, either for technical support or for software upgrade.
Also the CLIO system accessories have their serial numbers; keep track of those but mention to technical support ONLY UPON REQUEST.

When using your CLIO system you will normally use the FW-02 front connectors. As you'll become extremely familiar with this hardware unit we are going to give it a nickname: from now on we will call it 'the CLIO Box'. Also the CLIO software refers to it with this nickname.
3.6.2 THE FIRST RUN

The following steps will guide you through a complete verification of the system performance and operation.

From the Start Menu choose Programs, then CLIO 12 and click on the CLIO icon.

The program should start smoothly and present the main desktop.

If the system is not calibrated, as the first time you run it, you will receive the following message.

Should CLIO display an error message take note of it and go to the troubleshooting section.

3.6.3 INITIAL TEST MEASUREMENT

Let's now execute our first test measurement - play and capture a 1kHz sinusoid. First of all click on the In-Out Loop button for channel A; in this way the CLIO Box connects output A with input A with an internal relay. This connection is very important as it lets you capture and analyze a signal generated by CLIO without the need for an external connecting cable.

Then click on the generator icon to play the 1kHz sinusoid (1031.25Hz to be exact; more on this later, it's the default signal). Then press the F4 keystroke to invoke the Multi-Meter as in Figure.
If everything is OK you should obtain a reading of circa 1V, variable between a minimum of 0.95V and a maximum of 1.05V, which is the mean output level of a sinusoidal signal when the system is not calibrated.

Now press the FFT button (or CTRL-F), then press the Oscilloscope button and finally the GoButton.

The result you should obtain is an FFT analysis of the 1kHz sinusoid (one spectral line @ 1kHz at 0dBV) and its time representation given by its oscillogram.

Both Multimeter and FFT results must present stable and repeatable; the oscillogram should display a sinusoid without spikes or drops of any kind.

**IMPORTANT NOTE:** Only if these two initial tests gave correct results, as described, go to the following paragraph and execute the system calibration; if you are not able to obtain these results and they seem in any way corrupted do not execute calibration and contact technical support.
3.7 SYSTEM CALIBRATION

This section describes how to perform the system calibration.

Be sure that, any time you perform a calibration, the system has warmed up for, at least 15-20 minutes.

Select Calibration from the Main menu;

Leave the CLIO Box front plugs unconnected.

Answer OK to the initial prompt; this will run an automatic procedure that will last several minutes. The calibration procedure is completely automatic and several progress indicators will accompany all the executed measurements. At the end of it your CLIO system should be calibrated and ready to carry out measurements.

Software won't allow calibration if internal temperature lies outside a predetermined range (between 30 to 45 degrees).

So it is normal to receive a message like:

It is also normal to receive the following message:

This is normally due to the calibration parameters that do not match the internally stored parameters that have been measured at Audiomatica laboratory and that ensure the highest precision of the instrument. In such a case either wait to repeat calibration if instrument is too cold for it to warm, or wait for the device to cool if too hot.

At the end of the calibration process it is always mandatory to verify the calibration itself; this is done by two simple measurements as described in the following
paragraph 3.7.1 CALIBRATION VALIDATION.

Only if this message appears consider to take proper action:

![Error message](image)

Calibration is a computer system resources demanding task.

Your computer would be best operated at high performance level:

![Power options settings](image)

When using a notebook **never run on batteries**, always hook it to AC mains, as power saving schemes greatly reduce performances. As ultimate resource these are Recommended Advanced Power Settings, i.e. set 100% the Minimum processor state:
If you are not able to perform calibration please follow procedures given in 3.9 TROUBLESHOOTING CLIO INSTALLATION to get in contact with Audiomatica technical support.

CLIO has been designed to give the user a high degree of precision, while maintaining ease of use thus ensuring confidence in the measurements taken. Calibration check plays a key role in all this. Note that, as calibration needs to be performed under controlled conditions, **calibration should be attempted the least times possible**; calibration, on the other side, should be **verified** as needed or requested all the times the user wants following instructions given next; verification, not calibration, of your hardware gives maximum confidence when taking measurements.

### 3.7.1 CALIBRATION VALIDATION

To verify the calibration, first check that the generator output level is set to 1V (refer to chapter 4 for details).

Press the channel A In-Out Loop button 🔄.

Then click on the MLS&LogChirp button 🎶 to invoke the MLS&LogChirp control panel. Press the Go 🔄 button to execute a LogChirp frequency response measurement; after about **1 second** you should obtain the desired result, a straight line (black) as in Figure. You can click on the graph and inspect the amplitude of the measured signal: you should obtain a reading around 0dBV, this is the correct output level of the LogChirp signal with the generator output set to 1V.

Now click on the Sinusoidal button 🎧 to invoke the Sinusoidal control panel as in Figure. Press the Go 🔄 button to execute a Sinusoidal frequency response measurement; after about **3 seconds** you should obtain the desired result, again a straight line (black) as in Figure. You can click on the graph and inspect the amplitude of the measured signal: you should obtain a reading around 0dBV.
To ensure a 100% correct calibration you also need to inspect the phase responses of both measurements. To do this press the phase button and verify that you obtain a straight line (red curves) the readings in this case should be around zero degrees in both cases.

As a final test click on the In-Out Loop button for channel A; then click on the In-Out Loop button for channel B; then be sure that both input sensitivity are at 0dBV; click on the generator icon to play the 1kHz sinusoid; at last press the F4 keystroke to invoke again the Multi-Meter; the expected result is shown now.
3.8 CLIO SERIAL NUMBER AND DEMO MODE

Each CLIO system has its own **serial number** which plays an important role since the CLIO software is hardware protected and relies on a correct serialization in order to run.

Refer to 3.6 to identify your system's serial number.

If the CLIO software doesn't find a CLIO Box with a correct serial number it gives a warning message and enters what is called **DEMO mode**; in this way it is possible to run CLIO in a PC where the CLIO hardware is not installed while still allowing you to perform post-processing and other off line jobs.

3.9 TROUBLESHOOTING CLIO INSTALLATION

To receive assistance please contact Audiomatica at support@audiomatica.com or connect to our website www.audiomatica.com.

**NEVER FORGET TO SIGNAL PROPER SERIAL NUMBER OF YOUR CLIO!**

When getting in contact with us please always send, as attachment to your email, the System Info file of your CLIO system.

To create this file choose MainMenu>Help>SystemInfo. **If your system has not completed calibration create the system info file right after the calibration has failed.**

![CLIO System Info](image)
4 CLIO BASICS

4.1 INTRODUCTION

This chapter gives you the basic information about CLIO and the related hardware and how to connect and operate it, while the following chapters explain in more detail the individual measurements available to users of CLIO. Chapter 5 deals with other general functionality of CLIO.

Here you will find information about:
- Help
- Main desktop, toolbars and menu
- Shortcuts
- Generator, Input and Output, Microphone
- Amplifier & SwitchBox, Turntables
- Connections

4.2 GETTING HELP
To request the CLIO on-line help press **F1**. The CLIO manual will be open by the default pdf reader.

The CLIO help can be invoked also from outside CLIO; to do this go to the Start Menu, then Programs, then CLIO12 and then click on 'CLIO Help'.

Another way to obtain help is through the Help Submenu which gives you the possibility to view the on-line resources available in the Audiomatica and CLIO websites.

Finally there are the dedicated buttons on the main toolbar.

Invokes the Help control panel.

Invokes the Internet On-Line Help.

### 4.3 CLIO DESKTOP

The CLIO desktop presents itself as in figure and gives you access to the (upper) **main toolbar** and the (lower) **hardware controls toolbar**.

Inside the main toolbar and the hardware controls toolbar you can locate several distinct functional areas as shown in the above figure. Now follows a description of the Main Menu and all the controls inside the two toolbar.
4.4 MAIN TOOLBAR & MAIN MENU

The Main Menu is accessible clicking on the dedicated button on the main toolbar or with the **ALT-M** shortcut.

From top to bottom it gives you access to the **File Submenu, Analysis Submenu, Controls Submenu, Window Submenu** and **Help Submenu**.

Then it displays a list of **Recently Opened Files**, there is the **Calibration** choice and, finally **Exit** from the program.

### 4.4.1 FILE SUBMENU

Please refer to Chapter 5 for information about the **File Submenu** and its shortcuts.

### 4.4.2 MEASUREMENT ANALYSIS BUTTONS & SUBMENU

By clicking on these toolbar buttons it is possible to interact and display each measurement control panel. Once the toolbar button is clicked the appropriate panel will be opened or reactivated. Any currently active panel will automatically be deactivated on activation of the new one.

- Enters the MLS&LogChirp Analysis control panel.
- Enters the Directivity&3D Balloon control panel.
- Enters the Time Frequency Analysis control panel.
- Enters the Acoustical Parameters control panel.
- Enters the FFT&RTA Analysis control panel.
- Enters the Sinusoidal Analysis control panel.
Enters the Multimeter control panel.

Enters the Thiele&Small Parameters control panel.

Enters the Wow&Flutter control panel.

Enters the Leq control panel.

Enters the Linearity&Distortion control panel.

Enters the Loudness Rating calculator.

Enters the Quality Control Processor.

The same functionality will be obtained with the relative **shortcuts** or by making a selection inside the Analysis Submenu.

**CTRL+M**
Enters the MLS&LogChirp Analysis control panel.

**CTRL+W**
Enters the Directivity&3D Balloons control panel.

**SHIFT+CTRL+W**
Enters the Time Frequency Analysis control panel.

**CTRL+A**
Enters the Acoustical Parameters control panel.

**CTRL+F**
Enters the FFT&RTA Analysis control panel.

**CTRL+S**
Enters the Sinusoidal Analysis control panel.

F4
Enters the Multimeter control panel.

CTRL+T
Enters the Thiele&Small Parameters control panel.

CTRL+Alt+W
Enters the Wow&Flutter control panel.

CTRL+L
Enters the Leq control panel.

CTRL+D
Enters the Linearity&Distortion control panel.

CTRL+R
Enters the Loudness Rating calculator.

CTRL+Q
Enters the Quality Control Processor.

4.4.3 CONTROLS SUBMENU
Refer below to Hardware Controls.

4.4.4 CALIBRATION
This option will perform a calibration of your CLIO hardware. Please refer to chapter 3 and follow the procedure described.

In order to determine, at any given time, if it is necessary to calibrate CLIO do the following:
- Let the system warm up
- Proceed to perform the verification described
- Consequently decide whether or not to calibrate

The result of the measurement may vary in some way from the time we calibrated because of many small changes in measurement conditions, including changes in the atmospheric conditions, the season, and the mains voltage.

Note: the CLIO hardware is highly precise and stable and, under normal operating conditions, does not require frequent calibrations.
Always perform a calibration if:
- CLIO asks for it showing the “System Not Calibrated” message
- You reinstalled CLIO in a different computer
- You installed a software upgrade

4.4.5 AUTOSCALE

Enables autoscale. When autoscale is active the software, during measurements, determines the optimum Y-scale settings.
4.5 HARDWARE CONTROLS TOOLBAR

Hardware controls are accessible either from the Hardware Controls Toolbar or Submenu. The Toolbar is described in detail starting from left to right controls; the Submenu is described when the keyboard shortcuts are needed.

4.5.1 INPUT CONTROL

**channel A input peak meter**
Constantly monitors channel A input signal level vs. full digital input scale.

Controls channel A input polarity.

**channel A input sensitivity display & control buttons**

Displayed the actual input A sensitivity (in dBV) of the instrument, i.e. the voltage level beyond which the hardware saturates. It is possible to modify it in 10dBV steps choosing it or pressing the (F9) and/or (F10) buttons.

**channel B input peak meter**
Constantly monitors channel B input signal level vs. full digital input scale.

Controls channel B input polarity.

**channel B input sensitivity display & control buttons**

Displays the actual input B sensitivity (in dBV) of the instrument, i.e. the voltage level beyond which the hardware saturates. It is possible to modify it in 10dBV steps choosing it or pressing the (F9) and/or (F10) buttons.

Links input channels sensitivity controls. If this button is pressed the two channel sensitivities are set equal and channel A controls act also on channel B.

Selects the Autorange mode. When in autorange mode the input sensitivity is automatically adjusted by the instrument to achieve the optimum signal to noise ratio.
4.5.2 INPUT/OUTPUT LOOPBACK

The CLIO Box features an internal loopback which is very useful for performing self tests.

Connects channel A output to channel A input with an internal relay.

Connects channel B output to channel B input with an internal relay.

4.5.3 GENERATOR CONTROL

CLIO's generator can be controlled from the dedicated toolbar buttons and dialogs; for a reference about the possible kind of signal you may generate please see chapter 7.

output level display & control buttons

Displays the actual output level (usually in Volts) of the internal generator. This level is valid for both output channels. It is possible to modify it in 1dB steps pressing the \( \downarrow \) (F7) and \( \uparrow \) or (F8) buttons. If the Shift key is pressed simultaneously then the steps are of 0.1dB increments.

It is also possible to input a numeric value directly with the following dialog which pops up when you click on the output level display.

In this case (manual input) the output level will be approximated with a 0.01dB precision. If you right-click on the output level display you invoke the output units pop up from which it is possible to select the output level unit among dBu, dBV, V and mV.

Checking the **Unbalanced** option the output level display is referred to the unbalanced outputs of the Clio Box. When this mode is selected the generator output level display is shown in white with black background.
Checking the **QCBox** option the output level display is referred to the unbalanced outputs of the QCBox. When this mode is selected the generator output level display is shown in black with red background.

When one of the output is muted (see below the associated shortcuts **CTRL+F7** and **SHIFT-CTRL+F7**) this is reflected by a red color inside the Out box aside the level display. If both output are muted the Out box background is totally red.

Switches on and off the generator.

Use the **ESC** key to immediately **kill** the generator.

If you wish to receive a confirmation message before playing the generator then check the appropriate box in the CLIO Options>General tab (chapter 5).

**ALT-G** It is possible to switch on the generator with this particular hot key; see 5.4.1 GENERAL settings.

**generator drop down menu**

Clicking on the small arrow beside the generator button will invoke the generator drop down menu, from there it is possible to choose the output signal type to be generated. The default signal at startup is a 1031.25Hz sinusoid.

Refer to Chapter 7 Signal Generator for a detailed description of all the features of the generator.

### 4.5.4 MICROPHONE CONTROL

**A** Switches Channel A 24V phantom power on and off. This supply is capable of operating any balanced microphone and also to operate Audiomatica's microphones MIC-01, MIC-02, MIC-03 or MIC-04.

**B** Switches Channel B 24V phantom power on and off. This supply is capable of operating any balanced microphone and also to operate Audiomatica's microphones MIC-01, MIC-02, MIC-03 or MIC-04.

To enter the microphone sensitivity please refer to CLIO Options>Units Conversion (chapter 5).
4.5.5 HARDWARE CONTROLS SUBMENU

Within this submenu we learn all the keyboard shortcuts associated with the controls described up to now.

ESC
Immediately kills the generator. Equivalent to releasing \( \text{Esc} \)

F7 Decreases the output level of 1dB. Equivalent to \( \downarrow \)

SHIFT+F7
Decreases the output level of 0.1dB. Equivalent to SHIFT+\( \downarrow \)

F8 Increases the output level of 1dB. Equivalent to \( \uparrow \)

SHIFT+F8
Increases the output level of 0.1dB. Equivalent to SHIFT+\( \uparrow \)

CTRL+F8
Opens the Generator Input Level dialog.

CTRL+F7
Mutes/Unmutes channel A.
SHIFT+CTRL+F7
Mutes/Unmutes channel B.

F10
Increases channel A input acceptance of 10dBV. If the Link Button $A^B$ is pressed then decreases also channel B input acceptance of 10dB.

SHIFT+F10
Increases channel B input acceptance of 10dBV. If the Link Button $A^B$ is pressed then increases also channel B input acceptance of 10dB.

F9
Decreases channel A input acceptance of 10dBV. If the Link Button $A^B$ is pressed then decreases also channel B input acceptance of 10dBV.

SHIFT+F9
Decreases channel B input acceptance of 10dBV. If the Link Button $A^B$ is pressed then increases also channel B input acceptance of 10dBV.

CTRL+P
Switches channel A microphone power supply on and off. Equivalent to $A$

CTRL+ALT+P
Switches channel B microphone power supply on and off. Equivalent to $B$

SHIFT+F4
Enters the QCBox and LPT control panel. Equivalent to $

CTRL+F4
Enters the Turntables Controls panel. Equivalent to $

F6
Enables/disables autoscale. Equivalent to $

4.5.6 SAMPLING FREQUENCY

48kHz
Indicates the current sampling frequency of the instrument. To change it simply click on it and refer to CLIO Options>Hardware (chapter 5).

4.5.7 TEMPERATURE

39 C
Indicates the current internal temperature of the instrument.
4.6 QCBOX & PORTS CONTROLS

Enters the QCBox & Ports Controls dialog box.

This control panel helps you when you are operating the CLIOQC Amplifier & SwitchBox. You may choose the Amplifier & SwitchBox model and set its functions. These controls are self-explanatory and are also covered in the unit's user's manual; along this manual we will refer to it as the Amplifier & SwitchBox or simply QCBox.

Depending on software version there are other tabs that allow direct controls over different external hardware like parallel port bits.

4.6.1 DEDICATED CONTROL OF THE PARALLEL PORT

TTL bits from a standard LPT port can be used to control an external device like a turntable.

You can set the proper PC parallel port (LPT):

Note: Parallel Port (LPT) legacy drivers are available only for 32-bit Windows; they are not furnished with the CLIO software but are freely available for download from Audiomatica.
4.6.1 DEDICATED CONTROL OF THE QCBOX MODEL 5

With this dialog box it is possible to access to the QCBox 5 enhanced features.

It is possible to:
- Set the output current protection threshold in the range 0÷10A
- Add a DC voltage (±20 V) on the amplifier output
- Set the input power supply (to operate a microphone) in the range 0÷24V
- Measure the output current
- Measure the load connected to output
- Measure DC voltage at IN 3 and IN 4 (and refer it to displacement when a laser is connected).
- Set output bits of the Digital IO port
- Read input bits of the Digital IO port
- Read Pedal input bit
4.7 CONTROLLING TURNTABLES

This control panel allows the control of one or two turntables. The control of two turntables is available only with the QC software version. Using two turntables it is possible to measure the loudspeaker response in three dimensions, i.e. the software can send commands to the turntables to aim the loudspeaker under test in a given direction.

- Reset turntable position to angle 0 by clockwise rotation (degrees up)
- Reset turntable position to angle 0 by counterclockwise rotation (degrees down)
- Set turntable reference angle (0 degrees)
- Goto angle by clockwise rotation (degrees up)
- Goto angle by counterclockwise rotation (degrees down)
- Step angle by clockwise rotation (degrees up), note that the step size is a turntable setting that cannot be accessed from CLIO
- Step angle by counterclockwise rotation (degrees down)
- Stop the turntable rotation

Connect turntables and link the turntable.
positions to the measurements

Display turntable current angle (top) and next angle (bottom), while the turntable is rotating the bottom background is highlighted in red.

- Open the Autosave Settings dialog
- Reset turntable angles according to Autosave Settings
- Open the Turntables Option dialog
- Start an MLS Autosave measurement set
- Halt an MLS Autosave measurement set
- Resume an MLS Autosave measurement set
4.7.1 TURNTABLES OPTIONS DIALOG

With this dialog it is possible to choose which model of turntable to use for each rotating axis (polar and azimuth). The software can take full control of the Outline ET250-3D, the LinearX LT360, the FangBo FT360 turntables or the Four Audio ELF robot. It supports also (limited to the polar rotation) a TTL pulse control (using the Digital IO of the QCBox Model 5 or, if present, the Parallel Port of the PC) which can be used to trigger the Outline ET/ST turntable or any other device. Using the combo box it is possible to choose which turntable model to use and its settings.

Outline ET250-3D

The Outline ET250-3D uses an Ethernet connection, please refer to the manufacturer documentation to setup the device. In the option dialog it is necessary to input the turntable IP and TCP/IP port.

Note: In order to work properly the basert.dll file must be present into the CLIO installation directory.

LinearX LT360

The LinearX LT360 turntable uses an USB or COM connection, please refer to the manufacturer documentation to setup the device. In the option dialog it is needed to input the communication port to be used.

Some turntables settings, such as the rotation speed and the velocity profile must be managed using the software supplied with the turntable. For correct operations with CLIO software the “Display Readout Polarity” setting of the LT360 turntable must be set on “Unipolar”.

Note: In order to work properly the lt360lib.dll file must be present into the CLIO installation directory.
**FangBo FT360**
The FangBo FT360 turntable uses a COM connection, please refer to the manufacturer documentation to setup the device. In the option dialog it is needed to input the communication port to be used.

**Four Audio ELF**
The Four Audio robot uses a COM connection, please refer to the manufacturer documentation to setup the device. In the option dialog it is needed to input the **communication port** to be used. To work properly both turntable settings must be manually set to the **same** COM port that controls the robot.

The **delay** parameter (in milliseconds) puts the software in a wait state after the completion of the turntable rotation, this can be useful in a non anechoic space to let the energy in the room to decay between measurements.
TTL pulse control (Outline ET/ST Turntable)

Selecting TTL pulse it is possible to control a turntable using a TTL signal. This is valid only for the polar angle and with this selection it is not possible to use two computer controlled turntables. In this case the second turntable can be only selected as “Manual”.

![TTL pulse control interface](image)

The TTL pulse control uses the digital IO output port of the QCBox model 5 or, if available, a Parallel Port (LPT) of the PC.

**Note:** Parallel Port (LPT) drivers are available only for 32-bit Windows. In case of 64-bit Windows use a QCBox Model 5.

The information given next apply to the control of the Outline ET/ST Turntable; they can be adapted to any other device.

Using a **QCBox Model5**: the control is achieved with Bit 5 of the QC Box digital I/O port, the turntable should be connected to the QCBox 5 output port by means of a cable (DB25 female to DB9 female) connecting the following pins:

- QCBox5 connector (DB25 male)  ➔ ET/ST connector (DB9 male)
- Pin 6  ➔ Pin 2
- Pin 14  ➔ Pin 4
- All other pins unconnected

![QCBox Model5 digital IO connection](image)

Using a **Parallel Port (LPT)**: the control is achieved with Bit 7 of the output bits, as shown in figure. The turntable should be connected to the parallel port of the computer by means of a cable (DB25 female to DB9 female) connecting the
The cable should be connected as in the following figure.

Inside the Turntable Option panel it is possible to set its **Step** value (in degrees) and **Speed** (in rotations per minute); the combination of these settings give the software an indication about how much time to wait after the controlling pulse is output.

**Manual**
For the azimuth angle only is it possible to choose the “Manual” turntable. This means that the azimuth rotation of the loudspeaker under test must be managed manually. Instead of automatically control the turntable, the software display a pop-up message to the operator and wait for the completion of the manual rotation.

Please refer to chapter 12 for further information on polar measurement sets.
4.8 BASIC CONNECTIONS

4.8.1 CONNECTING THE CLIO BOX

In order to correctly interface CLIO with the outside world you should always keep in mind the following electrical specifications:

**MAXIMUM INPUT VOLTAGE:** +40 dBV (283 V peak-to-peak)
**MAXIMUM OUTPUT VOLTAGE:** +18dBu (6.156Vrms) (sine)
**INPUT IMPEDANCE:** 128 kOhm
**OUTPUT IMPEDANCE:** 660 Ohm

The CLIO system is stereo and can simultaneously process two balanced analog I/O channels which are named channel A and B.

**INPUT CHANNELS**

The CLIO Box input uses two XLR Combo female connectors. These particular connectors accept also a 6.3mm standard jack.

Using a standard 6.3mm MONO jack is the easiest way to input unbalanced signals to CLIO.

Two 6.3mm mono jacks are supplied in each CLIO system package.

**OUTPUT CHANNELS**

The CLIO Box output uses two XLR male connectors. In parallel you also find two RCA plugs that are used to take the output signal unbalanced.

Please note that there it will always be a 6 dB difference between the CLIO balanced and unbalanced outputs.

By default the Output Level display is referred to the balanced output, in this case the unbalanced output level is 6 dB lower. In order to display the unbalanced output level it is necessary to select the proper option in the Output Level display; in this case the balanced output is 6dB higher than the unbalanced one.

The output of channel B is usually driven in parallel with channel A output.

As generator controls suggest all internally generated signal are 'mono', so they are
played. The easiest way to have different output per channel is to play a stereo .wav file with desired content in each channel.

**INPUT-OUTPUT SCHEMATIC AND LOOPBACK**

The following schematic illustrates the input-output structure of one channel:

![Input-output schematic](image)

To be noted the internal analog loopback that can be activated with the relative buttons described earlier.

**REAR PANEL CONNECTIONS**

On the rear panel you also find an RCA connector for digital **SPDIF** output. SPDIF output is a digital replica of analog output and constantly follows it. No controls are available on this data stream.
4.8.2 CONNECTING A MICROPHONE

For acoustical measurements, the microphone (optionally followed by a preamplifier or power supply) requires to be connected to CLIO's input channel.

When using a MIC-01, MIC-02, MIC-03 or MIC-04 microphone it is possible to connect it directly to CLIO's input; remember, in this case, to switch the phantom voltage on by pressing the phantom button. It is good practice to wait a few seconds before taking measurements as the microphone's output stabilizes.

If the measuring point is far from the PC, always lengthen the connection between the preamplifier and CLIO. Make sure that you never use microphone cable that is longer than the one that has been supplied.

In figure we see the typical test setup for performing acoustical measurements of a loudspeaker. Please note that in this schematic diagram the output of the power amplifier is connected to the loudspeaker with an inversion in the cables polarity; this compensates the fact that microphones are usually phase inverting; when making polarity measurements always treat the measuring chain in this respect considering that the CLIO hardware itself is NON-INVERTING and that all calibrations are usually made under this assumption: any external device like amplifiers, microphones, accelerometers, preamplifiers etc. has to be carefully checked.

It is possible to achieve the same result, via software, simply clicking on the input polarity button in the hardware controls toolbar.
4.8.3 CONNECTING THE CLIOQC AMPLIFIER & SWITCHBOX

The CLIOQC Amplifier & SwitchBox is the natural companion of the FW-01 Audio Interface to carry out your measurements.

There are two distinct mechanical assemblies that enhance the final result as:
- They create the best possible ground connection between cases.
- The assembly forms a single instrument and is more convenient to use

For fixed installations in standard 19” rack housings; perfect for Quality Control production lines.

Compact, space saving solution; perfect for laboratory use.

The figures below show the connections of a CLIOQC Amplifier & SwitchBox to CLIO. Refer also to the unit's user's manual for details.
The unit has its internal switcher set for response measurements.

These are the connection for impedance measurement in **ISense Mode**.
5 SYSTEM OPERATIONS AND SETTINGS

5.1 INTRODUCTION

This chapter completes the introduction to CLIO started in Chapter 4. Here you will find information about:

- Files extensions
- File operations and shortcuts
- Exporting data
- Exporting graphics
- Printing
- Software option
- Desktop control
- Calibration of CLIO
- Startup options
- Measurements settings

5.2 REGISTERED FILE EXTENSIONS

During its installation CLIO registers several file extensions which will let you easily find a file done during your work. Browsing your hard disk you will then encounter the icons that we are going to describe.

- MLS&LogChirp data files.
- MLS&LogChirp process files.
- 2D Directivity & 3D Balloons data files.
- Time Frequency data files.
- Acoustical Parameters data files.
- FFT and RTA data files.
- Sinusoidal data files.
- Sinusoidal process files.
- Multi-meter data files.
- T&S parameters data files.
- Wow&Flutter data files.
Leq data files.

Linearity&Distortion data files.

Multitone definitions files.

Autosave definitions files.

Desktop snapshot files.

CLIO setup files.

OLD CLIO Signal files; not used but supported.

OLD MLS&LogChirp impedance data files; not used but supported.

OLD Sinusoidal impedance data files; not used but supported.

OLD Waterfall,Directivity & 3D data files; not used but supported.

OLD Wavelet data files; not used but supported.

When you find a CLIO data file it is possible to invoke the program simply clicking on the file itself; if CLIO is open it will load the file in the appropriate menu and display it, if it is closed it will be launched then the file opened.

If you click on a Desktop snapshot file you will recall a saved work session comprising open menu and data (see below).
5.3 FILE SUBMENU

The figure shows the File Submenu and the shortcuts active.

F3 Saves a measurement file relative to the active control panel.

F2 Loads a measurement file relative to the active control panel.

ALT+F2 Enters the Autosave Settings dialog box.

SHIFT+F2 Enters the ASCII exports dialog.

CTRL+F2 Enters the Graphics exports dialog.

ALT+P Prints the active measurement.

5.3.1 LOADING AND SAVING FILES

loads a CLIO measurement file or compatible file.

It is important to note that, usually, it is possible to load more than one data file.

You can select the desired file type from the 'Files of type' drop down inside the Open dialog box.

When choosing 'All CLIO measurements files' then the Open dialog will display all
available files otherwise they can be filtered by type like MLS Files (*.mls, *.mlsi).

A measurement file can be opened also simply **dragging** it onto CLIO Desktop using the mouse.

Recalls the Save As Dialog to save current measurement data in a binary measurement file relative to the active control panel. It is important to note that the following menu save more than one data file type:

- **MLS** saves frequency response files (*.mls) or impulse response as wave files (*.wav)
- **FFT** and **Leq** save measured binary files (*.fft or *.leq) and captured data wave files (*.wav)
5.3.2 AUTOSAVE SETTINGS

Invokes the Autosave Settings dialog. It is possible to define the autosaving rules that will be followed by the measurements capable of this feature (MLS and Sinusoidal).

There are two different Autosave modes: **1D** and **3D**. **3D mode is available only in QC version.**

1D mode:
There are five settings which serve to define the 1D **autosaved file name**:
- **Path** defines the folder where the file will be saved; it is possible to choose it clicking on the browse for folder button … In figure we see path defined as My Documents\Audiomatica
- **Root File Name** defines the part of the file name that will not change during Autosave; in figure it is 'RogersHalfChirp'.
- **Start** defines the initial number appended to the root. This number will always be multiplied by 100 to give space for two decimals management. Numbers are appended with spaces. In figure start is -180; this will define the first autosaved file name as 'My Documents\Audiomatica\RogersHalfChirp -18000'
- **Increment** defines the increment to be given to the autosaved file names. In the example of figure the second autosaved file will be named 'My Documents\Audiomatica\RogersHalfChirp -17500' and so on
- **Total Number** defines the number of autosaved files after which the process is automatically ended
3D mode (ONLY in QC version):
There are several settings which serve to define the **autosaved file name**:
- **Path** defines the folder where the file will be saved; it is possible to choose it clicking on the browse for folder button. In figure we see path defined as My Documents\Audiomatica.
- **Root File Name** defines the part of the file name that will not change during autosave; in figure it is 'RogersHalfChirp'.
- **Polar Start** defines the polar angle start
- **Polar Step** defines the polar angle step
- **Polar Stop** defines the polar angle stop
- **Azimuth Start** defines the azimuth angle start
- **Azimuth Step** defines the azimuth angle step
- **Azimuth Stop** defines the azimuth angle stop

Please refer to chapter 12 for the definition of polar and azimuth angles.

It is possible to save in the standard binary file format (Bin) and/or to export in text format (Txt). The **MLS Export Size** button:

selects the number of export data points for MLS ASCII files.

It is possible to save and load these definitions in an Autosave Definition file (*.asd).
5.3.3 EXPORTING ASCII DATA

CLIO is able to export the currently active measurement in an ASCII file (*.txt).

Upon performing this choice you will be prompted by the Export dialog.

To File
Depending on the measurement menu you are working with, it will be possible to choose different data to export to a file on disk.

To Clipboard
ASCII data will be copied to Windows Clipboard.

Also XLS
In parallel to the ASCII file it is created also an Excel spreadsheet with the same filename and .xls extension.

TAB Delimited
Uses TAB instead of spaces as delimiter.

5.3.4 EXPORTING GRAPHICS

CLIO is able to create enhanced metafiles (*.emf), bitmaps (*.bmp), portable network graphics (*.png), JPEG (*.jpg) or GIF (*.gif) of the currently active measurement. The graph is drawn using the same colors and settings of printouts; you can define them with the CLIO Options>Graphics dialog.

Black&White
Check the box to discard color information.

Optimal Settings
CLIO chooses graphics settings for you overriding system defined ones.

To Clipboard
Graph will be copied to Windows Clipboard.

5.3.5 NOTES ABOUT MEASUREMENT

Enters the Notes dialog where it is possible to input comments to be saved with the actual measurement and inspect other measurement information. Check boxes enable printing notes and exporting notes to graphics files.

5.3.6 PRINTING

Prints the current active measurement. The definition of printing colors and font settings is done with the CLIO Options>Graphics dialog.
5.4 CLIO OPTIONS

- Opens the CLIO Options dialog box

5.4.1 GENERAL

Opening this tab you can define the following:
- The **Company Name** which will appear in all printouts.
- Some **On Exit** settings regarding when the program has to prompt and if you want to autosave and reload the measurement session.
- The **Signal Generator and Multimeter settings**.
- The location of the **Hardware Controls Toolbar**.
- The behavior of the graph **on file load**.
- The style and behavior of the **graphic curve display**.

![CLIO Options dialog box](image-url)
5.4.2 UNITS CONVERSION

Opening this tab you can define the following:
- Enter the microphone sensitivity and the microphone response correction.
- Enter all other transducers sensitivity and reference levels.

**MICROPHONE SENSITIVITY**

When taking acoustical measurements, the readings and the scales will be in Pascals (Pa, dBSPL, dBPa or dBPa/V). In this case, the software will assume that you are measuring a pressure quantity and it therefore needs to know a conversion factor that defines the voltage produced by the microphone when it is measuring a certain pressure. This conversion factor is usually the sensitivity of the microphone (as found in the microphone’s calibration chart) or the sensitivity of the microphone + preamplifier chain of equipment.

If you are working with the CLIO system standard accessories there are two possible cases:

a) you may use a microphone MIC-01, MIC-02, MIC-03 or MIC-04 directly connected to FW-01; as the FW-01 powers the microphone with 24V while sensitivity is factory checked at 8.2V it is necessary to input the given sensitivity of the microphone (in mV/Pa) **increased of 3.3dB i.e. multiplied by 1.465.**

b) you are using the PRE-01 preamplifier, it is necessary to know its internal gain; if it is 0dB then input the microphone sensitivity, if it is +20dB then input the microphone sensitivity multiplied by 10.

**NOTE:** It is necessary to input two separate sensitivities, one for channel A and one for channel B.
 Please also refer to chapter 8 for a description of the controls useful to capture the sensitivity of the microphonic chain when using an acoustic calibrator capable of producing a known pressure.

**CORRECTING THE MICROPHONE RESPONSE**

By checking the Frequency Correction check boxes the software will correct the measured curve according to the data stored in two text files, which you have to provide.

**Note:** microphone correction will affect the measured curve only if dBSPL (or dBPa or dBPa/V) is selected as Y Scale unit.

The microphone correction files, if present, must be placed inside the installation folder (usually c:\program files\audiomatica\clio12\).

These text files containing the correction data must have .CAL extension; the default names are “MICA.CAL” (for input channel A) and “MICB.CAL” (for input channel B) but you may use any.

To instruct CLIO which file to use you may load from disk clicking on the file name:

You have to load separately one correcting file per each channel you want to correct.

**GUIDELINES TO REALIZE .CAL FILES**

**Note:** The maximum number of correcting points allowed is 100.

The example below shows a sample text file created to store the microphone frequency response:

<table>
<thead>
<tr>
<th>Freq</th>
<th>dB</th>
<th>Phase</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4000</td>
<td>0.25</td>
<td>0</td>
</tr>
<tr>
<td>8000</td>
<td>0.33</td>
<td>0</td>
</tr>
<tr>
<td>10000</td>
<td>0.5</td>
<td>0</td>
</tr>
<tr>
<td>15000</td>
<td>1.75</td>
<td>0</td>
</tr>
<tr>
<td>20000</td>
<td>2.5</td>
<td>0</td>
</tr>
</tbody>
</table>

**USING CALIBRATION FILES FURNISHED BY AUDIOMATICATA**

If your microphone came with frequency calibration data supplied by Audiomatica (see chapter 2) you can find the correction file inside the furnished disk.
The file is stored with the name **serialnumber.cal**; for example in the disk given with the microphone with serial 5213431204 you will find the “5213431204.CAL” file.

To use it (for channel A) you must:
1) Copy it inside the CLIO installation folder
2) Load it as described above
3) Check the Frequency Correction box

Looking at the calibration chart you will also find sensitivity data:

![Calibration Chart](image1)

In the picture below it is displayed the final situation provided you have also set the proper mic sensitivity (in this example 14.69*1.465=21.52 mV/Pa).

![Sensitivity Settings](image2)

**DISPLACEMENT, VELOCITY, ACCELERATION, CURRENT, POWER**

Set the sensitivity for each of these units where used in the program.

**dBREL REFERENCE**

Sets the voltage reference for the unit dBRel.

**dBPa/V REFERENCE**

When measuring with dBPa/V it is possible to use as reference level:
- the dBRel reference voltage
- CLIO output level (balanced)
- CLIO output level (unbalanced)
- QCBox Output
- Output of any amplifier of a given gain in dB connected to the balanced output
5.4.3 GRAPHICS

Opening this tab you can define the following:
- Screen Colors
- Print (and graphics export) colors
- Screen line width
- Print (and graphics export) line width and font size.

Apart from the Default color scheme, which is not changeable, it is possible to load and customize up to 6 different color schemes: Classic (for old CLIO users), User1, User2, User3, User4 and Printing. The Printing color scheme, as the name implies, will affect your printouts (and exported graphic files) and, if selected, will let you preview how they appear on your screen.

Default button
When defining a color scheme you may press the Default button which will load the Default scheme for your reference. If you are modifying the printing color scheme it will load the default printing colors.

5.4.4 HARDWARE

Within this tab you can select the sampling frequency of the FW-01 unit. It is possible to choose either 48kHz, 96kHz or 192kHz.
5.5 DESKTOP MANAGEMENT

Desktop management is a powerful feature that lets you save your work at a certain point and reload exactly as it was.

It is possible to do this automatically when exiting CLIO; at successive startup the program will automatically reload from where you left; to do this activate the **Save measurement session** from CLIO Options>General.

- Load a previously saved measurement session (*.sna files).
- Takes a snapshot of current measurement session and saves it to disk (*.sna files).
- If pressed clears current measurement desktop i.e. closes and resets all measurement menu. It is also possible to clear one single measurement selectively opening and choosing from the associated drop down menu.
5.6 STARTUP OPTIONS AND GLOBAL SETTINGS

You can start CLIO directly clicking on the **CLIO.exe** executable that is saved in the installation directory (usually C:\Program Files\Audiomatica\CLIO12 or C:\Program Files (x86)\Audiomatica\CLIO12); you may also access CLIO either from Start Menu>Programs>CLIO12 or creating a shortcut on your Desktop.

A second way to run CLIO is to click on a registered file; in this way you will not only run the program but also load the file into the appropriate measurement menu.

CLIO creates a temporary folder named **Temp** for several uses. This folder is located under the Common Application Data folder that has the following path (Windows XP):

C:\DocumentsAndSettings\AllUsers\ApplicationData\Audiomatica\CLIO12

or (Windows Vista, 7, 8 and 10):

C:\ProgramData\Audiomatica\CLIO12

CLIO relies, during startup, on a configuration file named **CLIOXP.stp** which resides in the temporary folder. This file is written each time the program ends and saves several settings that will be reloaded and reconfigure your system.

Among them we find (see chapters 4 and 5):
- program Options
- generator output level
- input sensitivity
- phantom power supply state
- autorange state
- microphone settings
- CLIOQC Amplifier & SwitchBox
- color scheme and other setup settings
- main window state
- global reference level
- autoscale state

**Note:** It is possible to return the system to its initial default state (after installation) by deleting the CLIOXP.stp file.

5.6.1 SAVING MEASUREMENT SETTINGS

Measurements settings can be saved from within the various measurement menu; to do this simply check the Save Settings box in the Settings dialog of each menu; refer to specific menu chapters for details on settings.

Settings are saved in the **mls.stp** (MLS&LogChirp), **sin.stp** (Sinusoidal), **fft.stp** (FFT), **d3d.stp** (Directivity), **tfa.stp** (Time Frequency), **acp.stp** (Acoustical Parameters), **lin.stp** (Linearity&Distortion), **leq.stp** (Leq) files inside the temporary folder. Upon finding one of these files at startup, CLIO will reset the corresponding menu to the saved settings.
6 COMMON MEASUREMENT INTERFACE

6.1 INTRODUCTION

This chapter deals with the graphical user interface which is used to display and manage the measured curves within all CLIO frequency measurement menus. In particular this Common Measurement Interface (CMI) is used by the FFT, MLS and Sinusoidal menu. The understanding of CMI behavior and capabilities is very important to use CLIO at its best.

6.2 UNDERSTANDING THE DISPLAY IN FRONT OF YOU

Fig.6.1 explains the main objects found in a frequency response measurement display.

Inside the graph you find the main curve A which reflects an executed (or loaded from disk) measurement; up to nine overlays curves which are stored by the user and can be controlled interactively, the two markers which are activated by clicking on the respective buttons.

Above the graph itself we find several buttons and checkboxes which divide into three main categories: Y scales controls, main curve, zoom and overlays management.

Each overlay can be displayed, hidden or selected with the relative checkbox.

Marker A reads curve A; marker B has a twofold operation: it reads the selected overlay, if present, otherwise reads again curve A.

Aside and below the graph we find the Y Scales, the Frequency (or Time) Scale and Marker Indicators. The Y scale is of the same color of the main curve selected.

The objects described may, from case to case, not all be present at the same time,
as in the case of Time Data display in the FFT menu. The frequency (or time) scale may be logarithmic or linear. A particular representation is the MLS time domain which will be discussed later in 6.6.

It is possible to have two graphs in the same control panel (see FFT). In this case one is referred as active after you have clicked on it.

To change the colors of the screen, main curve and overlays refer to section 5.4.

**6.2.1 STEREO MEASUREMENTS DISPLAY**

Fig.6.2 shows the differences that are present when a stereo measurement is taken or loaded from disk.

![Figure 6.2](image)

Now you find two **main curves A and B** with two appropriate checkboxes to control them; you may display, hide or select each of the main curves. By selecting a main curve the relative Y scale is activated and scale controls operate on it. If no overlay is present and selected marker B reads the main curve B, otherwise it reads the selected overlay.
6.2.2 COLLAPSING MARKERS

If you hold the SHIFT key pressed while moving the markers with the mouse you will obtain that the two markers collapse into a single one reading the same frequency point.

6.2.3 DIRECT Y SCALES INPUT

It is possible to direct input of the Y scales values; to activate the input boxes simply click on the scale extremes.
6.3 BUTTONS AND CHECKBOXES

- Moves (shifts) the selected curve upward.
- Moves (shifts) the selected curve downward.
- Expands (magnifies) the selected curve; it also changes the Y scale respectively.
- Compresses (reduces) the selected curve; it also changes the Y scale respectively.
- Zooms the curve in; it is possible to execute multiple zoom in actions.
- Zooms out the curve completely i.e. returns to the default initial zoom state.
- Switches the main curve A on and off. In case of stereo measurements displays, hides or selects the main curve A.
- If present, for stereo measurements, displays, hides or selects the main curve B
  1. Stores the main curve selected into overlay 1. It also displays overlay 1.
  2. Stores the main curve selected into overlay 2. It also displays overlay 2.
  3. Stores the main curve selected into overlay 3. It also displays overlay 3.
  4. Stores the main curve selected into overlay 4. It also displays overlay 4.
  5. Stores the main curve selected into overlay 5. It also displays overlay 5.
  6. Stores the main curve selected into overlay 6. It also displays overlay 6.
  7. Stores the main curve selected into overlay 7. It also displays overlay 7.
  8. Stores the main curve selected into overlay 8. It also displays overlay 8.
  9. Stores the main curve selected into overlay 9. It also displays overlay 9.
- Displays, hides or selects the respective overlay. It also shows its color.
- Enables marker A.
- Enables marker B.
6.4 HOW TO ZOOM

1) Click on the Zoom+ button.

2) Position the mouse and PRESS the left mouse button at the beginning of your selection and **keep the mouse button pressed**. Don’t just click otherwise you get a warning message!

3) With the mouse button pressed move the mouse until the second selection point.

4) Only now release the left mouse button.

Be careful: you **must** have the button pressed from point 2) to point 4)!

**It is possible to zoom by direct input of the frequency extremes of the scale; to activate the input boxes simply click on the scale extremes.**

6.5 SHORTCUTS AND MOUSE ACTIONS

The following keystrokes and mouse actions are active:

- **up arrow**
  - equivalent to ✷ on the active graph

- **Shift+up arrow**
  - equivalent to ⌈ on the active graph

- **down arrow**
  - equivalent to ⌋ on the active graph

- **Shift+down arrow**
  - equivalent to ⌋ on the active graph

- **mouse click**
  - activates the graph; useful when more than one graph is present (see FFT)

- **mouse left down**
  - activates the marker

- **mouse left drag**
  - moves the marker

- **mouse wheel up**
  - equivalent to ✷

- **mouse wheel down**
  - equivalent to ▼
6.6 THE MLS TIME DOMAIN DISPLAY

When entering the MLS&LOG CHIRP (but also Waterfall or Acoustical Parameters) time domain you will find a different display (Fig. 6.2).

In this case there is only one overlay. It is also possible to select a portion of the main curve by means of three particular buttons. The selected portion of the main curve is identified by a start and stop point and is drawn in a different color from the unselected portion.

- Defines the start point of the selection. **Before clicking with the button activate Marker A and position cursor to the desired point.**
- Defines the stop point of the selection. **Before clicking with the button activate Marker A and position cursor to the desired point.**
- Returns the curve to a completely unselected state.
7 SIGNAL GENERATOR

7.1 INTRODUCTION

This chapter deals with the programmable signal generator of CLIO. Each paragraph explains a type of signal, its settings and gives a time frequency analysis obtained with the FFT narrowband analyzer (see chapter 9).

Refer also to chapter 4 for all hardware and software controls associated with the signal generator.

Clicking on the generator button drop down you access the signal generator menu.

7.2 SINUSOID

It is possible to generate sinusoids of given frequency. Select the Sin choice in the generator menu.

The sinusoid can be **continuous**; leave the two inputs Time On and Time Off at zero.
Or it can be **burst**ed; input the desired values in the Time On and Time Off inputs.

Select **FFT Bin Round** if you desire that the frequency is approximated to the nearest FFT bin (with respect to the actual FFT size setting).

The time envelope of the burst can also be shaped with an **Hanning** tapering window (see also later CEA Burst).

The following figure shows a 1031.25Hz continuous sinusoid.

The following figure shows a 100Hz bursted sinusoid.
7.3 TWO SINUSOIDS

It is possible to generate two sinusoids of given frequencies and amplitudes. Select the TwoSin choice in the generator menu.

The following figure shows a signal consisting of a 1031.25Hz and 2062.5Hz of same amplitude (50% each).
7.4 CEA BURST

It is possible to generate a particular burst signal useful for conducting the power test described in CEA-2010 norm.

![Generator Input Form]

It is possible to define the number of cycles of the sinusoids and the repetition time of the burst. Note that Cycles resolution is up to half sinusoid (6.5 in the example).
7.5 MULTITONES

It is possible to generate multitones (multiple sinusoids signals). Select the Multitone choice in the generator menu.

The following figure shows a multitone signal consisting of 31 sinusoids each with frequency corresponding to the center frequencies of the standard 1/3rd of octave bands from 20Hz to 20kHz and same amplitude.
7.6 WHITE NOISE

It is possible to generate a white noise. Select the White choice in the generator menu.

The following figure shows the white noise signal.
7.7 MLS

It is possible to generate MLS (maximum length sequences) of given length. Select the MLS choice in the generator menu.

These signals are the same used in the MLS analysis menu and should be used to test them.

The following figure shows a MLS signal of 32k length.
7.8 CHIRPS

It is possible to generate Chirps (sinusoids with frequency continuously variable with time between two extremes) in two different ways.

You may generate full spectrum Logarithmic Chirps of given length selecting the LogChirp choice in the generator menu.

These signals are the same used in the LogChirp analysis menu and should be used to test them.

You may instead define Chirps of given length, frequency extremes and kind (linear or logarithmic) selecting the Chirp choice in the generator menu.

The following figure shows a 20Hz to 20 kHz Log Chirp.
The following figure shows a 20Hz to 20 kHz Lin Chirp.
7.9 PINK NOISE

It is possible to generate Pink noises of given length. Select the Pink choice in the generator menu.

The following figure shows a Pink Noise signal of 32k length measured with the FFT narrowband analyzer.

Pink noise signals are used normally to execute Octave bands analysis with the RTA menu due to the flat response they produce when analyzed with fraction of octave filters.
The following figure shows the same Pink Noise signal of above measured with the RTA analyzer.
7.10 ALL TONES

It is possible to generate All Tones signals of given length; an All tones contains a sum of sinusoids of frequencies corresponding to each frequency bin with respect to their length and sampling frequency. Select the All choice in the generator menu.

The following figure shows an All Tones signal of 32k length measured with the FFT narrowband analyzer.

![FFT narrowband analyzer](image)

All Tones signals are used with the FFT narrowband analyzer due to the flat response they produce.
For comparison with Pink noises the following figure shows the same All Tones signal of above measured with the RTA analyzer.
7.11 SIGNAL FILES

As a last possibility it is possible to play signal files saved on disk. Standard '.wav' Windows Wave files are supported ('.sig' CLIO Signal files are supported for compatibility with older versions of the software).

Choose File within the generator menu. The default extension lets you select a CLIO signal file.

The following figure shows the IMPULSE(POSITIVE).WAV signal file.
The generator menu also keeps track of the recently generated signal files giving you instant access to them.

### 7.11.1 SAVING SIGNAL FILES

The generator menu allows you also to save the current signal present in memory to file. To do this choose Save Current Signal; the format supported is .wav.

**Note:** during MLS&LogChirp and Sinusoidal menu operation this function saves current MLS, Chirp or Sin sweep.

It is possible to generate .wav files also from the FFT, MLS&LogChirp and Leq measurement menu using the SaveAs function; FFT saves last captured time data, MLS&LogChirp saves impulse response, Leq saves all captured data.
7.12 THE GENERATOR CONTROL PANEL

All the above capabilities of generating and playing signals can be controlled with an handy stay-on-the-top panel, the Generator Control Panel.

It is possible to switch between signal on the fly by simply clicking on the dedicated buttons.
There are also two buttons to hi-pass and low-pass the generated signal with selectable edge frequency; here you see an all tones signal high pass filtered @200Hz.

The filtering applies also to MLS and Sinusoidal menu.
There is a third interactive feature of the Generator Control Panel not available elsewhere. The **Sweep** tab opens a three bands continuous sweeper that can be operated with the associated slider.

The normal **Coarse** control (over the entire frequency band) can be changed (pressing **Ctrl**) to a **Fine** tuning of ±1% centered around actual frequency.
8 MULTI-METER

8.1 INTRODUCTION

The Multi-meter is an interactive, real-time, measuring instrument.

It gives CLIO the functionality of a:
- Sound level meter (dBSPL, dBA, dBC)
- Millivoltmeter (V, dBV, dBu, dBr)
- Laser displacement meter (m, dBmeter)
- Laser velocity meter (m/s, dBm/s)
- Acceleration meter (m/s², g, dBm/s²)
- Frequency counter (Hz)
- Distortion meter (THD, THD+N, IMD) (%), dB)
- Power meter (W)
- Current meter (A)
- L-C-R bridge (H, uF, Ohm)

Recallable simply pressing F4, the Multi-meter has the capability of capturing the global reference level and the microphone sensitivity; it is rare that you enter CLIO and don't use the Multi-meter, the information and controls available here are of invaluable importance during the normal operation of the whole instrument.

8.2 MULTI-METER CONTROL PANEL

![Multi-meter control panel](image)

*Figure 8.1 Multi-meter control panel*
8.2.1 TOOLBAR BUTTONS

▶ Starts the measurement.

Log option

When checked data acquisition is logged as an ASCII table.

❖ Permits execution with the control panel in a minimized state. Only a small stay-on-the-top display remains visible showing the main parameter measured.

❖ Stops the measurement. If data logging is active user is prompted to save log data.

❖ If pressed displays all measured parameters. Beyond the main parameter the multimeter monitors some other quantities as displayed in Fig.8.1. These are:
  - THD
  - Frequency
  - IMD
  - IMD2
  - IMD3
  - Crest Factor (ratio between peak and average value)
  - AB interchannel phase (when in stereo operation)
Selects the main parameter to be measured.

Selects the measurement unit. Depends on the selected main parameter.

Selects the detector kind among RMS, AVG, Peak, PeakToPeak. Not applicable to the LCR meter.
Captures, when pressed, the actual reading of the Multi-meter as the **global reference level**, or **microphone sensitivity** if Pressure reading is active. See also CLIO>Options>Units Conversion.

Clicking on its side drop-down menu you inspect its important settings:

![Menu for global reference level](image)

or, if Pressure is selected

![Menu for microphone sensitivity](image)

Control the scale of the meter bar graph.

channel
Selects the input channel. Not applicable to the LCR meter.

**integration**
Selects between Fast (125ms) and Slow (1s) integration. Not applicable to the LCR meter.

**filter**

Enables Lo-pass and/or Hi-pass brickwall frequency filters on acquired data. Clicking on the drop-down menu it is possible to choose the filter type and appropriate cutoff frequencies by means of dedicated menu option.
8.3 LCR METER

When either Resistance, Capacitance or Inductance is selected as main parameter to be measured, the Multi-meter enters what is called **LCR Meter** state. The **LCR Meter** is a particular operating mode of the Multi-meter that gives you the possibility of measuring inductors, capacitors and resistors. This measurement is an **impedance measurement** and is carried out in **Internal Mode (see chapter 12 for details)**. The **LCR Meter** takes control of the generator and, when the measurement is started, outputs a series of sinusoids of variable frequency in order to find the best frequency to carry out the measurement. The output frequency can be displayed (with the magnifier button) together with the measured parameter. The LCR Meter operates only on channel A, @48kHz sampling.
8.4 INTERACTION BETWEEN THE MULTI-METER AND FFT

The Multi-meter uses the same capture and processing units as the FFT control panel. To perform a measurement it programs the FFT routines (changing FFT settings to match its needs) and then effectively starts an FFT measurement in background.

The two panels can be opened and can work together but FFT always acts as the master while Multi-meter as the slave. In this situation the Multi-meter window's title is changed to 'Multi-Meter (FFT slave)' to reflect this new state; the Go and Stop buttons are disabled as you operate the slave panel from inside FFT, starting and stopping the reading with the FFT's Go and Stop buttons; the input channel follows the FFT one while the integration setting become meaningless; this is because the user has control over FFT averages which precisely define the measurement integration. Nevertheless, during slave operation, it is possible to select the displayed parameter and its unit.

During slave operation it is not possible to select LCR operation as the LCR meter uses different measurement capabilities.

As soon as the FFT control panel is closed it releases Multi-meter from the slave state; then the Multi-meter is then ready to operate in a stand-alone capacity and is fully functional as described above.

8.5 MULTI-METER SHORTCUTS

G  Starts a multimeter measurement.

T  Stops current measurement.

8.6 MULTI-METER FILE TYPES

The registered file extension for Multi-meter measurement data files is '.met'.

Met data file.
9 FFT, RTA AND “LIVE” TRANSFER FUNCTION

9.1 INTRODUCTION

By selecting the FFT command from the main menu bar, it is possible to carry out Fourier analysis of the input signal to determine its frequency content using the Fast Fourier Transform (FFT).

The ability to process two channels simultaneously, to select the appropriate sampling frequency and the possibility of triggering with respect to the generated signal make this control panel a flexible and valuable instrument. Finally, there is also a very useful facility to quickly and easily swap back and forth between the time and frequency domains.

The FFT processed data coming from the two input channels can be displayed as narrowbands, octave bands (turning the instrument into what is generally called a real-time analyzer or RTA) or, referencing one to the other, as live transfer function (you may also use music as stimulus).

9.2 FFT ANALYZER CONTROL PANEL
9.2.1 TOOLBAR BUTTONS

- Starts an FFT measurement. Right-clicking on it you open the associated drop down menu.

- It is possible to select:
  - **Continue.** In this mode the measurement is not started from blank but accumulates with the previously stopped one.
  - **Event Trigger.** If selected the measurement is triggered by an input signal.

- Starts an FFT measurement. The icon becomes orange in case either Event Trigger or Internal Trigger are active.

- Stops the current measurement.

- Selects FFT Narrowband analyzer.
Selects RTA (octave bands) analyzer.

Selects FFT “Live” Transfer Function analyzer.

Enters the FFT Settings dialog box.
Enables the Time Data display. The second graph that is activated behaves as an oscilloscope and displays the captured waveform correspondent to the last FFT analysis.

Enables the Hold function. Depending on the setting entered in the FFT Settings dialog box, it is possible to hold either the minimum or maximum value per frequency point.

Moves the equal loudness curve up of 1phon.

Moves the equal loudness curve down of 1phon.

data window

Selects a weighting data window among the following:
  - Rectangular (no window)
  - Hanning
  - Hamming
  - Blackman
  - Bartlett (triangular)
  - FlatTop
channel display

Selects the input channel to display among the following:
- Channel A only
- Channel B only
- Channel A&B (both channels displayed in different graphs)

Y scale units

Selects the measurement units.
Note:
- dBRel (with respect to the global reference level; see chapter 8)
- dBSPL, dBPa (for acoustical measurements)
- dBmeter, dBm/s (for laser measurements)
- dBm/s^2 (for acceleration measurements)
- dBampere (for current measurements)

frequency smoothing
Selects the frequency smoothing in fractions of octave from 1/48 to 1/2 of octave.

fraction of octave (RTA analyzer only)
Selects between 1/1, 1/3 and 1/6 of octave analysis.

target averages
Inputs the total number of averages. Averaging is controlled by the setting in the FFT Settings dialog.

number of averages display
Displays the number of the actual average; this number increases during the measurement unless, while in exponential averaging, the target has already been reached.
9.3 FFT SETTINGS

**FFT Size**
Selects the number of samples acquired and processed by each FFT. It is possible to choose a size between 512 and 262144 points.

**Delay**
Permits the input of the desired processing delay (in ms) when in Internal Trigger mode.

**Internal Trigger**
Enables the Internal Trigger mode. Each FFT acquisition is then started when the signal, internally generated by CLIO, begins. Event trigger, see above, instead triggers on the signal present at input.

**Enable Frequency Calibration**
Enables frequency calibration to compensate for any hardware non linearity; frequency calibration, if enabled, takes place only when the generator is active.

**Hold Function**
Selects either Min or Max hold function. This functionality is activated by the relative toolbar button.

**Freq Axis**
Selects from linear or logarithmic frequency axis (valid only for FFT narrowband)

**Enable Equal Loudness Contour**
Enables the display of the normal equal loudness level curves as defined in the ISO 226 standard. The curves are displayed only in FFT narrowband and RTA modes when dBSPL units are selected.

**Averaging**
Selects either linear or logarithmic averaging.

**ANSI/CEA-2010**
Enables power test processing as per ANSI-CEA 2010 norm.
9.3.1 DEDICATED ‘LIVE’ SETTINGS AND TOOLBAR FUNCTIONS

Coherence Threshold
Selects the coherence threshold to display measured data. If set to zero all data are displayed. Otherwise only FFT bins with coherence above it will be shown.

Multi Resolution
Enables multiple FFTs (of decreasing length) to cover different frequency bands.

Phase
Enables the Time Data display. The lower graph displayed is the impulse response.

Coherence
Enables phase response to be displayed in the lower graph.

Computation Factor
Enables coherence response. The coherence is displayed in the same graph of the transfer function magnitude and reads on the right displays scale.

Automatically evaluates the interchannel delay and sets it. The value of the delay is shown in the delay display.

delay display
Shows the delay correction, in ms, that is applied while processing the two channels.

level threshold display and control
Sets the peak level versus input full scale of the reference channel below which the measurement is frozen. It is possible to modify the value using the dedicated spin buttons. Setting this threshold properly lets you measure only when the signal is present at the reference channel and avoid that inaccurate readings accumulates with the measure distorting it.

**Compression factor display**

Shows the difference, in dB, between the crest factors of the two input signals. The compression factor gives you a rough indication about how much the system under test is limited in its dynamic range. The more negative the compression factor more the system is limiting the input signal.

### 9.4 FFT AND MULTI-METER

There is a close interaction between FFT and Multi-meter operations. The two measurements share the same acquisition and processing core. Should they operate together the FFT control panel acts as the master while Multi-meter follows as the slave. In this situation, among other peculiarities, the Go and Stop buttons of the Multi-meter are disabled; if an FFT acquisition is started then the Multi-meter runs as well, the same when you stop the measurement.

### 9.5 FFT AND Leq ANALYZER

It is possible to execute FFT or RTA analysis while an Leq measurement is taking place. The following figure shows the analysis of a sample of speech done with Leq and RTA in parallel.

Some limitations apply to FFT settings, in particular it is not possible to select an FFT size higher than 32768. See also chapter 16.
9.6 FFT SHORTCUTS

G  Starts an FFT measurement.
T  Stops current measurement.
S  Invokes Setting menu.
F  Enters FFT narrowband analyzer.
R  Enters RTA analyzer.
L  Enters “Live” Transfer Function analyzer.
D  Invokes Time Data (Oscilloscope) display.
H  Invokes Hold function.

**Page-Up**  **Page-Dn**
Manually increase or decrease delay by 10ms.

**Shift Page-Up**  **Shift Page-Dn**
Manually increase or decrease delay by 1 sample.

9.7 FFT FILE TYPES

The registered file extension for FFT measurement data files is '.fft'.

[FFT data file]

9.8 FFT ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

**Display Frequency Data**
The program will export the processed frequency data as they are displayed on the screen, with its internal resolution of 2048 points, regardless the current FFT size.

**FFT Frequency Data**
The program will export the processed frequency data with the resolution of the current FFT size.

**Last FFT Data**
The program will export the last calculated FFT frequency data with the resolution of the current FFT size.

**Last Time Data**
The program will export the last captured time data with the resolution of the current FFT size.
10 MLS & LOG CHIRP

10.1 INTRODUCTION

MLS&LOG CHIRP menu features two different techniques that yield to the final result, the complex transfer function of a generic device. They are MLS and LOG CHIRP Analysis. While the internal processing is quite different the result is the same and this justifies keeping them together.

MLS stands for Maximum Length Sequences, is a powerful well established technique that allows you to carry out analysis of linear systems recovering the Impulse Response of the device using a fast cross-correlation algorithm. It is therefore a time based analysis. Frequency domain information is obtained calculating the FFT of the Impulse Response.

LOG CHIRP analysis uses a log-swept sine chirp as stimulus. The Frequency Response is obtained with a deconvolution process and the Impulse Response with an inverse FFT of the Frequency Response.

With MLS&LOG CHIRP it is possible to measure:

- **Impulse Response** of any generic DUT
- **Complex Transfer Function**
- **Group Delay**
- **Quasi-anechoic Frequency Response** of a loudspeaker
- **Room Acoustic Response**
- **Step Response**
- **Schroeder Decay**
- **ETC (Energy Time Curve)**

Within this Menu the user will be able to deal simultaneously with time and frequency domains using the powerful post processing tools CLIO provides. This allows the collection of very sophisticated and complete information of any electro-acoustic device.
10.2 MLS & LOG CHIRP CONTROL PANEL

10.2.1 TOOLBAR BUTTONS

▶ Starts an MLS & LOG CHIRP measurement.

If pressed the measurements will be autosaved. The current autosave definitions apply (see chapter 5).

If pressed the measurements will be autostored in overlays.

Selects the Loop mode. When in Loop mode the MLS & LOG CHIRP measurement is automatically repeated until the user presses a keystroke or releases the button. If Autosave is active the loop mode ends after the total files to be autosaved are done.

When an MLS & LOG CHIRP measurement is taken, it automatically applies the selected post-process.

Enters the MLS & LOG CHIRP Process dialog box.

Enters the MLS & LOG CHIRP settings dialog box.

Shows Time domain.

Shows Frequency domain.

Shows both Frequency & Time domains.

Displays phase.

Set wrapped or unwrapped phase.
Displays group delay.

By right clicking either on phase or group delay button the kind of calculation can be selected:

Normal displays the measured phase (group delay) curve referring to the selected time domain data.

Minimum calculates and displays the phase (group delay) curve, related to the current modulus curve, in the assumption of minimum phase behavior (i.e. the Hilbert transform of the log magnitude).

Excess calculates and displays the phase (group delay) curve as the difference between the Normal and the Minimum ones.

Displays Impulse Response.

Displays Step Response.

Displays Schroeder Decay.

Displays Energy Time Curve (ETC).

channel display

Selects the input channel to display among the following:
- Channel A only
- Channel B only

Y scale units
Selects the measurement units among the following:
- dBV
- dBu
- dBRel (with respect to the global reference level; see chapter 8)
- dB SPL (for acoustical measurements)
- dB Pa (for acoustical measurements)
- dBmeter (for laser measurements)
- dBm/s (for laser measurements)
- dBm/s² (for acceleration measurements)
- dBampere (for current measurements)

**smoothing**

Activates a frequency smoothing of the active curve. This smoothing effect will allow a better appreciation of the general features of the response curve. The smoothing algorithm that is employed averages all values within a fraction-of-octave band surrounding each analysis frequency.

**Automatic delay capture.** Based on the current impulse response finds and mathematically removes the impulse delay. The delay found is displayed in the nearby box, inside the Impulse Response control panel it also activates Marker B showing the delay.

The delay can also be fine tuned or set manually:
- clicking the dedicated buttons (in 0.01ms steps)
- with Page-up and Page-dn keys (in 0.01ms steps)
- with Shift Page-up and Shift Page-dn keys (in 0.1ms steps)
- with Ctrl Page-up and Ctrl Page-dn keys (in 0.001ms steps)
10.3 MLS & LOG CHIRP SETTINGS

**size**
Selects the size of the MLS & LOG CHIRP sequence. Log Chirp size spans from 4k to 2M samples (1M and 2M size are uncalibrated as are meant to be used for Room Acoustic response measurements). MLS size spans from 4k to 512k samples.

**window**
Selects the appropriate kind of window for analyzing time data. It is possible to select between a rectangular, Hanning or Blackman window; the last two can be full or half size. NOTE: These windows are applied to the time portion to be transformed with FFT. If the start point is near the impulse, full windows will null the most important part of the time response (due to their rise time). To evaluate the effects of a data window refer to Chapter 9, and FFT measurements in general.

**stimuli**
Selects the kind of stimulus, either MLS or Log Chirp used for the measurement.

**averages**
Controls the averaging mode of operation. The measurement will be repeated and averaged the number of times set, therefore obtaining a better signal-to-noise ratio at the expense of reduced measurement speed. Continuous performs the number of averages in the shortest time without waiting. Manual waits the user to press any key between each measure; it is useful, for example, in averaging different microphone positions.

**impedance**
Set how Impedance is calculated and displayed. When taking impedance measurements refer either to the Internal impedance mode or to QC Box Select (the hardware setting of the QC Box determines directly the Impedance Mode, refer to 4.6). When checking Ohm Right Scale the impedance is referred to the right Y scale.
10.4 IMPULSE RESPONSE CONTROL PANEL

The following buttons inside the measurement area are particular to this control panel. See Chapter 6 for other general information.

- Selects the starting point of the measurement window.
- Selects the end point of the measurement window.
- Restores the default state of the measurement window thus selecting all the acquired points for analysis.
- Stores and displays one impulse response overlay curve
- Activates marker A and B
10.5 MLS & LOG CHIRP POST-PROCESSING TOOLS

- Loads an MLS & Log Chirp process.
- Saves an MLS & Log Chirp process.
- Adds a data value or compatible file to the current measurement.
- Subtracts a data value or compatible file to the current measurement.
- Multiplies the current measurement by a data value or compatible file.
- Divides the current measurement by a data value or compatible file.
- Shifts the current measurement by a dB value.
- Multiplies the current measurement by complex frequency.
- Divides the current measurement by complex frequency.
- Uses a reference measurement file taken at speaker terminals to calculate 1m sensitivity in dBSPL/W. The reference file should have dBV Y units while the one in memory should be in dBSPL.
- Process the current measurement with an octave band filter. It is possible to input the mid-band value and the filter bandwidth.
- Temporally shifts the current measurement by a ms value. Affects phase response.
- Merges the current measurement with the part below the selected transition frequency of a selected compatible file.
- Combines the actual measurement and the selected file to obtain a constant current impedance measurement. Both files should be in dBV.
- Combines the actual measurement and the selected file to obtain a constant voltage impedance measurement. Both files should be in dBV.
10.6 MLS & LOG CHIRP SHORTCUTS

G  Starts a MLS & Log Chirp measurement.
Esc  Stops current measurement.
S  Invokes Setting menu.
F  Shows Frequency Response.
T  Shows Time Response.
P  Shows Phase (in Frequency Response).
    Shows Step Response (in Time Response).
D  Shows Group Delay (in Frequency Response).
    Shows Schroeder Decay (in Time Response)
I  Shows Impulse.
E  Shows ETC.

10.7 MLS & LOG CHIRP FILE TYPES

The registered file extension for MLS & Log Chirp measurement data files is '.mls'.
The registered file extension for MLS & Log Chirp process files is '.mpro'.

MLS & Log Chirp data file.
MLS & Log Chirp process file.

10.8 MLS & LOG CHIRP ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

Display Frequency Data
The program will export the frequency data as they are displayed on the screen, with resolution variable from 256 to 2048 points, regardless the current MLS size.

FFT Frequency Data
The program will export the frequency data with the resolution of the current MLS size.

Time Data
The program will export the acquired impulse response or active post process.
11 SINUSOIDAL

11.1 INTRODUCTION

Within Sinusoidal, it is possible to carry out simultaneous analysis of:
- **Frequency Response**
- **Impedance**
- **Distortion** (THD plus harmonics up to 10th)
- **Rub&Buzz**.

As should be obvious the stimulus used is a sinusoidal signal, stepped or continuously swept within user defined frequency limits. Although sinusoidal steady state analysis is among the oldest and more traditional kind of measure, CLIO merges the reliability of this well known technique with the power of advanced DSP.

The completely programmable Gating feature allows the user to add quasi-anechoic acoustical frequency response capability.

Simultaneous, two channels, **stereo measurements** can be performed.

11.2 SINUSOIDAL CONTROL PANEL

**11.2.1 TOOLBAR BUTTONS**

- **Starts the sinusoidal measurement.**
- If pressed the measurements will be autosaved. The current autosave definitions apply; see chapter 5 for details.
- If pressed the measurements will be autostored in overlays.
- Automatically applies the defined post-process after the measurement has been taken.
Enters the Sinusoidal Post-Process Dialog, described below.

When a stereo measurement is done divides channel A by channel B and shows result.

Displays the phase response instead of modulus response.

Enters the Sinusoidal Setting Dialog, described in detail below. It is the heart of the whole menu and should be thoroughly understood before pressing Go.

**Harmonic Distortion Selection**

If the distortion products have been calculated, interactively selects the one to be displayed.

Displays the selected distortion product, risen the dB defined in the Settings Dialog.

Displays Fast-Track Rub&Buzz, risen the amount of dB defined in the Settings Dialog. Note: Fast-Track Rub&Buzz is available only in QC software version.

Set output level equalize mode; after a sinusoidal measurement has been taken it is possible to refer to the acquired frequency response in order to generate a colored output that flattens out the subsequent response.

The above example illustrates a measured pressure response (red) that has then been equalized to obtain a flat output (black) from the same loudspeaker.
input channel

Selects the input channel (CHA or CHB). Choose CHA&B for a stereo measurement when the two channels are measured and processed simultaneously.

Y Scale units

Selects the measurement Y scale unit. Possible choices are dBV, dBu, dBRel as voltage, dBSPL, dBPa, dBPa/V as pressure, dBmeter as displacement, dBm/s as velocity, dBm/s² as acceleration, dBampere as current and Ohm as impedance. Refer to CLIO Options>Units Conversion dialog for reference sensitivities. Ohm switches the system to convert the measurements in Ohm basing the conversion on the Impedance Mode Settings available in the Settings Dialog. In stereo measurements both channels share the same unit, with one exception: when a stereo measurement is taken and the sinusoidal setting “Ohm Right Scale” is selected, then channel B measures impedance sensing current (usually from the dedicated QCBox ISense output).

Smoothing

Allows the user to select a frequency smoothing of the active curve. The smoothing algorithm averages all the value within the selected fraction of octave band, surrounding each analysis frequency. It is a non destructive post process that can be applied or removed at any moment after the measurement has been taken. Note: Smoothing is not active for Ohm scale and for Rub&Buzz.
11.2.2 SINUSOIDAL SETTINGS DIALOG

Sweep Settings

Stepped Check Box
Allows the user to choose between continuous or stepped Logarithmic Sweep. Continuous sweep is faster; the user should have clear how this may affect the measurements.

Speed Drop Down
Lets the user choose between Slow (max accuracy), Fast (optimized for Fast-Track Rub&Buzz) or Normal measurement speed. The resulting sweep time length in seconds may be read in the sinusoidal control panel status bar.

Resolution Drop Down
Lets the user choose between seven different frequency resolutions up to 1/192\textsuperscript{th} of octave. It affects the measurement execution time, whatever the other settings are.

Freq Max Edit Box
Lets the user define the highest Frequency of the Sweep. This is also the starting measurement Frequency. The highest value accepted is 22388 Hz. The value should also be one octave higher than the Minimum Frequency.

Freq Min Edit Box
Lets the user define the lowest Frequency of the Sweep. This is also the end measurement Frequency. The lowest value accepted is 10 Hz. The value should also be one octave lower than the Maximum Frequency.

Gating (Acquisition) Settings

Gated Check Box
Lets the user enable the gating acquisition mode. Checking it will automatically check Stepped Check Box. That is, Gated Measurements are always carried out in Stepped Mode.

Delay Edit Boxes
Lets the user define the delay, separately for each input channel, in ms, applied between the signal generation and its acquisition. When different than 0, gating
is active, even when gating or Stepped check boxes (but not both) are not checked. Typical gated use is quasi-anechoic Frequency Response analysis where it removes the time delay of the sound leaving the speaker and reaching the microphone. Alternative use, with gated not checked, might be removing the delay between the play and recording head in a three heads tape recorder as well as any digital processor that introduces delay in the signal path. The highest Delay value accepted is 1000ms.

**Auto Delay Check Box & Auto Delay Frequency Edit Box**
If Auto delay is checked, when delay is used (see above) CLIO tries, using the Frequency value entered, to determine the delay automatically. The value found is displayed in the Delay edit box; reopening the Settings dialog after the measurements has been taken allows you to view the automatically chosen delay time. The highest Delay value can be limited with the Max[ms] input to avoid wasting measuring time.

**Impedance Settings**
Set how Impedance is calculated and displayed. When taking impedance measurements refer either to the **Internal** impedance mode, to **QC Box Select** mode (the hardware setting of the QC Box determines directly the Impedance Mode, refer to chapter 4) or **2 Channels** mode.

**Ohm Right Scale**
If selected the impedance scale will be activated on the right of the graph. When a stereo measurement is taken, then channel B measures impedance sensing current (usually from the dedicated QCBox ISense output).

**Distortion Settings**

**R&B Enabled**

**THD Enabled**
Enables THD and Harmonics calculation.

**% Reading**
Sets distortion or R&B curves unit to % instead of dB.

**Rise [dB]**
Value, in dB, used by the graphical routines to raise the display of the distortion curves. Only the display of the curve is affected. The marker readings continue to display the real value which, if the rise value is different than 0, differs from the curve position.
11.3 SINUSOIDAL POST PROCESSING TOOLS

The Sinusoidal Processing Tools dialog gives access to very powerful mathematical tools that, once defined, can be saved, reloaded and automatically be applied to every executed measurement.

- Loads a Sinusoidal process.
- Saves a Sinusoidal process.
- Adds a data value or compatible file to the current measurement.
- Subtracts a data value or compatible file to the current measurement.
- Multiplies the current measurement by a data value or compatible file.
- Divides the current measurement by a data value or compatible file.
- Shifts the current measurement by a dB value.
- Multiplies the current measurement by complex frequency.
- Divides the current measurement by complex frequency.
- Uses a reference measurement file taken at speaker terminals to calculate 1m sensitivity in dBSPL/W. The reference file should have dBV Y units while the one in memory should be in dBSPL.
- Temporally shifts the current measurement by a ms value. Affects phase response.
- Merges the current measurement with the part below the selected transition frequency of a selected compatible file.
- Combines the current measurement and the selected file to obtain a constant current impedance measurement. Both files should be in dBV.
- Combines the current measurement and the selected file to obtain a constant voltage impedance measurement. Both files should be in dBV.
11.4 SINUSOIDAL SHORTCUTS

G Starts a Sinusoidal measurement.
Esc Stops current measurement.
S Invokes Setting menu.
P Shows phase response.
T Shows Distortion.
R Shows Rub&Buzz.

11.5 SINUSOIDAL FILE TYPES

The registered file extension for Sinusoidal measurement data files is '.sin'.
The registered file extension for Sinusoidal process files is '.spro'.

Sinusoidal data file.
Sinusoidal process file.

11.6 SINUSOIDAL ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

**Frequency Data**
The program will export the acquired frequency data with their fraction of octave frequency resolution.

**Frequency + Distortion Data**
As above plus THD and R&B data.
12 DIRECTIVITY & 3D BALLOON

12.1 INTRODUCTION

The Directivity & 3D Balloon post processing routines (3D post-processing is available only with QC version software) give CLIO the possibility to visualize and export directivity polar patterns or 3D polar response balloons.

Directivity analysis characterizes the radiation of a loudspeaker versus a single planar scan line (vertical or horizontal angle).

![Directivity Analysis Example](image)

The Directivity post processing permits the following analysis:

- **3-D directivity (waterfall like)**
- **Color map directivity**
- **Classical polar plots**

**3D Balloon analysis** characterizes the radiation of a loudspeaker over multiple scan lines or a set of points around the source.

![3D Balloon Analysis Example](image)
The 3D post processing permits the following (QC version software only):

- **3-D balloon visualization** at 1/48 octave and standard 1/3rd octave frequencies
- **Balloon Export** to EASE .xhn, CLF v2 .tab formats and as set of impulse responses in .txt format renamed for seamless import in EASE SpeakerLab
In the previous figures the Directivity & 3D Balloon control panel is shown in some of its possible configurations; as you may imagine the post processing capabilities of this menu are very powerful.

### 12.2.1 COMMON TOOLBAR BUTTONS AND DROP DOWN LISTS

- Starts a directivity or 3D balloon calculation.
- Select Directivity Analysis.
- Select 3D Balloon Analysis.
- Enters the settings dialog.
- Moves analysis frequency up 1/3 of octave (+SHIFT moves analysis frequency up 1/48 octave).
- Moves analysis frequency down 1/3 of octave (+SHIFT moves analysis frequency down 1/48 octave).

### 12.3 DIRECTIVITY MODE

A directivity analysis is a post process applied to a set of measured frequency responses. Please refer to chapters 9, 10 and 11 (FFT, MLS&LogChirp and Sinusoidal) to have details on how to measure a frequency response.

### 12.3.1 DIRECTIVITY SPECIFIC CONTROLS

- Mirror data (positive angle data is mirrored on negative angle)
- Display a frequency-vs-angle response plot in form of waterfall plot.
- Display a color map instead of waterfall plot.
- When in color map mode interpolates colors in order to obtain smooth level contours.
Moves the plot up (move the marker when in marker mode).

Moves the plot down (move the marker when in marker mode).

Expands the plot changing its Y scale. The Y range is reduced.

Compresses the plot changing its Y scale. The Y range is increased.

Selects an half space polar pattern.

Activate marker mode (available only for waterfall plot)

12.3.2 DIRECTIVITY SETTINGS

Start Frequency
Selects the start frequency for the analysis.

Stop Frequency
Selects the stop frequency for the analysis.

Root File Name and browse button
The name of one file within the set to be displayed. By pressing the associated button it is possible to browse the disk and choose the file.

Z-Start
Value associated to the first (rearmost) file.

Z-Stop
Value associated to the last (foremost) file.

Z-Ref
Value associated to the file to be taken as reference.

Reference
If selected the directivity spectra will be referenced to the one identified by the Z-Ref value.
Smoothing
Selects the frequency smoothing of polar data.

12.3.3 DIRECTIVITY OPERATION

The radiation characteristics of a loudspeaker or driver versus frequency and angle rely on a huge amount of data i.e. a set of frequency responses (taken at different angles on the vertical or horizontal planes) saved to disk; for example it is common to work with sets of 72 files representing the frequency response taken at 5 degrees angles to represent a complete rotation in a plane.

With the directivity analysis you get a powerful way for synthesizing a large number of measurements in a single color map or 3-D graph. This control panel allows the representation of the classical polar response of a loudspeaker.

In order to identify the set of files it is important that all of their names follow a particular syntax, that gives certain information to the processing routines.

The syntax follows: <NAME><UNITS><VALUE*100>.MLS.

NAME is a common file name, UNITS are the common measurement units (to be displayed in the graph as Z axis label) and VALUE is a unique value identifying the single file; these quantities needs to be separated by spaces, it is possible to give negative numbers to VALUE. For example 'mydriver deg -250.mls' is a valid file name: as the name tells it is a measurement named mydriver with units deg taken at -2.5 (250 divided by 100) units value. If the units are not specified within the name then the processing defaults to deg.

The auto-saving and naming capabilities of CLIO render the job of measuring and creating a complete polar directivity data set an easy and automatic task.

It is possible to identify one file within the set as the reference with the Z-ref value; when in reference mode all calculations will then be done referenced to it.

BASIC STEPS:

In order to import and visualize a set of polar responses you should follow this steps:

- Open Directivity and 3D Balloons menu.
- Select ☑️ Directivity Analysis.
- Open the ☄️ Settings Dialog.
- Click on the Browse Button (...) to select the file set.
- Edit the other Settings field accordingly to the data set (Z-Start, Z-Stop and Z-Ref) and analysis requirements (frequency range, Smoothing and reference).
- Click ▶️ Go button to import and visualize the directivity data set.
- Choose one of the different available views.

12.4 3D BALLOON MODE

A 3D Balloon analysis is a post process applied to a set of measured MLS&LogChirp frequency responses. Please refer to chapter 10 (MLS&LogChirp) to have details on how to measure a frequency response.
Please note that the 3D analysis module is available only in the QC version of the software.

**12.4.1 3D SPECIFIC CONTROLS**

เตรียนหรือเปลี่ยนขนาดของมาม่าโอพล็อก โดยลดขนาดของมาม่าโอ

เตรียนหรือเปลี่ยนขนาดของมาม่าโอพล็อกโดยเพิ่มขนาดของมาม่าโอ

กรุณาแสดงแผนที่ความกระจายตัวของมาม่าโอ

กรุณาแสดงแผนที่ความกระจายตัวตามแนวแนวนอน

กรุณาแสดงแผนที่ความกระจายตัวตามแนวแนวนอน

มองจากมุมมองที่ด้านบนของมาม่าโอ

มองจากมุมมองที่ด้านล่างของมาม่าโอ

มองจากมุมมองที่ด้านซ้ายของมาม่าโอ

มองจากมุมมองที่ด้านขวาของมาม่าโอ

มองจากมุมมองที่ด้านหน้าของมาม่าโอ

มองจากมุมมองที่ด้านหลังของมาม่าโอ

แสดงกล่องคู่มือที่ใช้งาน

ถ้ากดแล้วจะแสดงมาม่าโอเป็นสีตามค่าลดทอนที่นั้นเทียบกับค่าที่อยู่บนแนวนั้น

เปิดเมนูถอดมาม่าโอ
12.4.2 3D SETTINGS

Root File Name and browse button
The name of one file within the set to be displayed. By pressing the associated button it is possible to browse the disk and choose the file.

Sampling
Select between “Equiangular” and “Free” sampling schemes over the spherical surface.

Symmetry
Select the file set symmetry between: None, Half, Quarter, Axial and H+V. Available only when “Equiangular” sampling is selected.

Phi Ref. Angle
Phi reference angle of the file set. The Phi=0 angle is by CLIO conventions oriented as the positive direction of the x-axis. If the data set is saved with a different Phi angle origin the Phi Ref. Angle setting allow to set this. Available only when “Equiangular” sampling is selected.

Theta and Phi Resolution
Resolution of sampled data set in both Theta (polar) and Phi (azimuth) angles. Select between 5, 10, 15, 30, 45 and 90 degrees. Available only when “Equiangular” sampling is selected.

Interpolation Mode
Select between “Bilinear” and “IDW” (Inverse Distance Weighting). Bilinear mode is available only when “Equiangular” sampling is selected.
CLIO internally manage 3D Balloon according to “AES56-2008: AES standard on acoustics - Sound source modeling - Loudspeaker polar radiation measurements” which recommends an equiangular sampling scheme with 5 degree angular resolution.
In Bilinear mode missing data is linearly interpolated from available sampled points. Bilinear mode should be preferred in case of equiangular under-sampled data sets.
In IDW mode missing data is interpolated following a potential functions approach. Details on the method could be found in the AES Convention Paper “Inverse Distance Weighting for Extrapolating Balloon-Directivity-Plots” (J. Panzer and D. Ponteggia). IDW mode is best suited when sampled data is sparse.

**Weigh. Factor \( u \)**
Select between “Equiangular” and “Free” sampling schemes over the spherical surface. The IDW formula calculates the missing data point \( y \) from the available data points \( x_i \) using their distance \( d_i \) power \( u \).

\[
y = \frac{\sum 1/d_i^u x_i}{\sum 1/d_j^u}
\]

The parameter \( u \) should be adjusted to give the best interpolation of the missing data points. It has been shown empirically that values comprised between 2 to 3 give the best results.

**Limit IDW Range**
Limit the data points \( x_i \) to the nearest possible (given the data set). Available only when “Equiangular” sampling is selected.

**Smoothing**
Selects the frequency smoothing of 3D Balloon data.

**Balloon Data Set**
The picture shown on the Balloon Data Set group-box give a visual hint to help in the selection of the correct 3D import options. The Balloon Data Set graph is a cloud of points which is interactively updated during the selection of 3D options. Points are shown in different colours:
- RED: Data point requested by current settings but not available on selected data set (if selected)
- GREEN: Data point requested by current settings and available on selected data set
- GRAY: Data point not requested by current settings but available on data set

**12.4.3 3D OPERATION**
The radiation characteristics of a loudspeaker or driver versus frequency and direction rely on a huge amount of data i.e. a set of frequency responses (taken at a given resolution) saved to disk.

With the 3D analysis you get a powerful way for synthesizing a large number of measurements in a single balloon graph.

In order to identify the set of files it is important that all of their names follow a particular syntax, that gives certain information to the processing routines.

The syntax follows: \(<\text{NAME}>\langle\text{PHI*100}\rangle\langle\text{THETA*100}\rangle.\text{MLS}\)

NAME is a common file name, PHI is the polar angle and THETA is the azimuth
angle. These quantities are separated by spaces.

The coordinate system used by CLIO is defined as follows:

\[ (x, y, z, \theta, \phi) \]

THETA is the polar angle between the loudspeaker axis and the measurement microphone, PHI is the azimuth angle. Positive THETA angles are related to the **counterclockwise rotation of the measuring microphone** (this is an apparent rotation since it is the loudspeaker that is rotating clockwise on the turntable) around the loudspeaker. Positive PHI angles are related to the counterclockwise rotation of the DUT around its on-axis direction (again this is an apparent rotation since the loudspeaker that is rotating clockwise).

The on-axis point has coordinates THETA=0 for every PHI angle. The PHI=0 angle lies on the horizontal xz plane, while PHI=90 angle lies on the vertical yz plane.

It is possible to import polar measurement set with either negative and positive values of THETA and PHI.

The auto-saving and naming capabilities of CLIO render the job of measuring and creating a complete 3D directivity data set an easy and automatic task.

**BASIC STEPS:**

In order to import and visualize a set of polar responses you should follow this steps:

- Open Directivity and 3D Balloons menu.
- Select 🌈 3D Balloon Analysis.
- Open the 🌌 Settings Dialog.
- Click on the Browse Button (...) to select the file set.
- The Balloon Data Set “cloud of points” shows available measurements of the data set as Green and Grey dots. Missing data points are in Red. Selecting the Sampling, Symmetry, Start Angle and resolution settings...
interactively changes the Balloon Data Set. This allows for an easy selection between the multiple options available.
- If the Balloon Data Set picture do not show Red points, you should proceed and select Interpolation and Smoothing settings.
- Click \( \Rightarrow \) Go button to import and visualize the directivity data set.
- Choose one of the different available views.

### 12.5 EXPORT 3D BALLOON DATA

The 3D Balloon mode feature a powerful tool to export the measured data towards the most common simulation software formats (EASE, CLF v2, EASE SpeakerLab).

The process of creation of the loudspeaker model for a simulation software require the measurement of the directional response of the loudspeaker.

Once the 3D data set is measured, with the 3D analysis tool it is possible to check data consistency and inspect the directional characteristics of a source.

The \( \square \) Export Balloon button opens the Balloon Export form.

**Output Format**

Selects the export format between the following.

- **EASE .xhn ASCII format**: Export of a single text file in EASE .xhn format. The file contains data in tabular format in 1/3 octave bandwidth (magnitude only, no complex data).
- **CLF v2 .tab**: Export of a single text file in Common Loudspeaker Format CLF v2 .tab format. The file contains data in tabular format in 1/3 octave bandwidth
Impulse Responses: Set of Impulse Responses (CLIO time data) in ASCII .txt format. The files are named according the filename convention used by EASE SpeakerLab to import CLIO Time Files:

IR <PHI*100> <THETA*100>.txt

The PHI and THETA angle are adjusted by the export routine to fit the unipolar angular coordinate system of EASE SpeakerLab, where PHI can range from 0 to 360 and THETA from 0 to 180.

Balloon-Symmetry (CLF only)
Set the output balloon symmetry according to CLF v1 definition (full, vertical, horizontal, none, rotational, polar).

Output File(Folder): defines the file name and location where the file will be saved; it is possible to choose it clicking on the browse for Choose Output File button (...).

General Information
Sets general information on loudspeaker model to be exported. Loudspeaker Model and Loudspeaker Manufacturer are text field which will be included in the file.

Frequency Range [Hz] is the exported range to be included in the file. Selectable values are from 100 Hz to 10 kHz in case of EASE .xhn and from 25 Hz to 20 kHz in case of CLF v2 .tab. The frequency range to export can be modified using the combo boxes.
Available only in EASE .xhn ASCII format or CLF v2 .tab formats.

On Axis Response
The On-Axis Response group let the user decide to use the data set on-axis measurement or use an MLS file as on-axis reference. Pressing the browse button (...) it is possible to select the reference MLS file 1W/1m. If option Use Balloon Data is selected, the on axis response is calculated using the on-axis measurement already present in the balloon set. Since the level should be referenced to 1W/1m there is the possibility to apply a dB shift to the on-axis measurement in order to compensate for different measurement distance and drive level. The Level Shift [dB] can be directly edited on the text box or calculated (under the assumption of a point source) by a given measurement distance [m] and drive level [W] and pressing the Calc button .
Available only in EASE .xhn ASCII format or CLF v2 .tab formats.

Impedance & Power
Pressing the browse button (...) it is possible to select the Impedance File curve to be exported into the file. If option Use Nominal Impedance [ohm] is selected, the impedance is set to the value present in the edit box.

Power [W] is the nominal power of the speaker to be inserted in the file. Available only in EASE .xhn ASCII format or CLF v2 .tab formats.

Time Windowing
This feature is available when output format CLIO time data is selected. In this mode each individual polar measurement is exported as time data .txt with CLIO MLS&LogChirp time data format.
If the Enable Windowing checkbox is not selected, the impulse response is exported without any time windowing applied. Elsewhere "Window Begin", "Window End" and "Window Type" are used and windowing is applied. Please note that the values between t=0 and Window Begin are set to 0 in order to keep the information of the time of flight embedded into the response measurement. The values on the edit boxes are preset to the values saved in the .mls files, but can be edited.

If the Truncate Text option is selected the .txt files are limited to the time points up to the Window End time. This saves storage space on disk and computation time when importing the text files in EASE SpeakerLab.

By default the measurements exported are only those imported by CLIO accordingly to the Sampling, Resolution and Symmetry settings previously shown. The files are also saved with PHI and THETA angle adjusted to fit the unipolar angular coordinate system of EASE SpeakerLab.

If the Raw Export option is selected all .mls files with the root file name of the imported set which are into the same folder are exported. In this case names are not adjusted. This feature is useful as example when data is collected with an angular resolution finer than 5 degrees.

Once the output text file is saved, it may be necessary to edit it with a text editor to add or modify information.

Following figure shows an example of a data set exported to CLF v2. tab format and then imported by the CLF authoring software.
12.6 SHORTCUTS

G  Starts a Directivity processing.
S  Invokes Setting menu.
D  Select Directivity Analysis.
B  Select 3D Balloon Analysis.

12.7 FILE TYPES

The registered file extension for Directivity measurement data files is '.d3d'.

Directivity data file.

Also supported are old file types:

OLD Directivity data file.
13 THIELE & SMALL PARAMETERS

13.1 INTRODUCTION

This chapter deals with Thiele & Small Parameters estimation and the description of the Thiele & Small Parameters Menu.

To estimate T&S Parameters CLIO needs either:

- Two distinct impedance measurements (with the loudspeaker in two different load conditions)
- One single impedance measurement where one T&S Parameter is fixed
- One two-channels measurement where impedance is evaluated along displacement using a laser transducers

CLIO performs impedance vs. frequency measurements either from within the MLS or the Sinusoidal Menu. Both are relevant to what we will now cover.

To obtain an impedance measurement CLIO allows for five distinct methods. Three of them, Internal, QCBox Select and 2 Channels are available from the Settings Dialog, both in MLS and Sinusoidal and require a single measurement. Constant Voltage and Constant Current are available from the Process mathematical tools dialogs and require two distinct voltage measurements.

13.2 T&S PARAMETERS CONTROL PANEL

The User Interface has four Buttons and one Check Box.

Starts a T&S Parameters procedure. Possible cases:
- 2 impedance measurements: see 13.3 for an example.
- 1 impedance measurement: see 13.3 while fixing one parameter among Mms, Mmd, Cms or Bl.
- 1 two-channels impedance plus displacement: execute the measurement within sinusoidal where impedance (channel B) is evaluated along displacement (channel A) using a laser transducer.
Delta Mass T&S Parameters calculation. See 13.3 for an example.

Delta Compliance T&S Parameters calculation. See 13.3 for an example.

Data Selection

Allows selecting the data origin:
- **File Data** loads an impedance file from disk
- **MLS Data** loads current data in MLS menu
- **Sin Data** loads current data in Sinusoidal menu

**LSE**

The LSE Check Box enables a Least Square Error routine while calculating T&S Parameters.
13.2.1 GLOSSARY OF SYMBOLS

Besides information regarding the device tested, the T&S Control Panel displays 27 parameters:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$F_S$</td>
<td>Resonant frequency of driver including air load</td>
</tr>
<tr>
<td>$V_{AS}$</td>
<td>Volume of air having the same acoustic compliance as driver suspension</td>
</tr>
<tr>
<td>$R_E$</td>
<td>DC electrical resistance of voice coil</td>
</tr>
<tr>
<td>$Q_{MS}$</td>
<td>Q of driver at $F_s$ considering mechanical losses only</td>
</tr>
<tr>
<td>$Q_{ES}$</td>
<td>Q of driver at $F_s$ considering electrical resistance only</td>
</tr>
<tr>
<td>$Q_{TS}$</td>
<td>Q of driver at $F_s$ considering all driver losses</td>
</tr>
<tr>
<td>$B\cdot l$</td>
<td>Motor strength, product of $B$ times $l$</td>
</tr>
<tr>
<td>$dB_{SPL}$</td>
<td>Acoustic pressure produced by the driver at 1m when driven by 2.83 V</td>
</tr>
<tr>
<td>$S_D$</td>
<td>Effective surface area of the driver cone</td>
</tr>
<tr>
<td>$C_{MS}$</td>
<td>Mechanical compliance of driver suspension</td>
</tr>
<tr>
<td>$M_{MS}$</td>
<td>Mechanical mass of driver cone assembly including air load</td>
</tr>
<tr>
<td>$R_{MS}$</td>
<td>Mechanical resistance of driver suspension losses</td>
</tr>
<tr>
<td>$C_{AS}$</td>
<td>Acoustic compliance of driver suspension</td>
</tr>
<tr>
<td>$M_{AS}$</td>
<td>Acoustic mass of driver cone assembly including reactive air load</td>
</tr>
<tr>
<td>$R_{AS}$</td>
<td>Acoustic resistance of driver suspension losses</td>
</tr>
<tr>
<td>$C_{MES}$</td>
<td>Electrical capacitance representing the driver total moving mass</td>
</tr>
<tr>
<td>$L_{CES}$</td>
<td>Electrical inductance representing the driver mechanical compliance</td>
</tr>
<tr>
<td>$R_{ES}$</td>
<td>Electrical resistance representing the driver mechanical losses</td>
</tr>
<tr>
<td>$R_{AT}$</td>
<td>Total acoustic resistance of driver</td>
</tr>
<tr>
<td>$R_{MT}$</td>
<td>Total mechanical resistance of driver (suspension losses + electrical reflected)</td>
</tr>
<tr>
<td>$M_{MD}$</td>
<td>Mechanical mass of driver cone assembly excluding air load</td>
</tr>
<tr>
<td>$Z_{MIN}$</td>
<td>Minimum impedance in the frequency range above $F_s$</td>
</tr>
<tr>
<td>$Z_{MAX}$</td>
<td>Impedance at $F_s$</td>
</tr>
<tr>
<td>$Z_{AVG}$</td>
<td>Average of impedance modulus over the measured frequency limits</td>
</tr>
<tr>
<td>$\eta_0$</td>
<td>Efficiency</td>
</tr>
<tr>
<td>$L_{1kHz}$</td>
<td>Inductance at 1kHz</td>
</tr>
<tr>
<td>$L_{10kHz}$</td>
<td>Inductance at 10kHz</td>
</tr>
</tbody>
</table>
The classical way to get T&S parameters requires two impedance measurements. As we will use both methods we need three, the first relative to the driver in free air, the second to the driver with a known mass (Delta Mass) added to the cone, the third to the driver loaded with a known volume (Delta Compliance). Figure shows the results of the three measurements, overlaid in one single graphic.

The black curve refers to free air, the red to delta mass, the green to delta compliance. As you can see adding a mass results in lowering Fs while loading the cone with a closed volume will increase Fs. Always check this is the case to avoid errors in the post processing routine. As deriving T&S parameters can be performed at any subsequent time after the impedance measurements has been taken, we suggest you save them with meaningful names as well as using the Notes Dialog to store the measuring conditions as mass weight and/or volume. The last step before pressing Go in the T&S dialog is to measure both the voice coil DC resistance and the effective cone diameter in millimeters. In this example they are 6.41 Ohm and 133mm. Finally we select File Data as the data origin and pressing Go we get the following prompt Dialog.
After the correct values have been typed in and clicking OK we will be prompted for the file name. The file required here is the free air impedance measurement.

Loading the file we get this partially filled T&S parameters screen i.e. the free air T&S parameters.

Notice that the two Buttons for Delta Mass and Delta Compliance that were disabled before are now enabled. We Click on the Delta Mass Button and type in the required values.
and, finally, after we have choose the impedance file obtained with the added mass, we get our completely filled T&S parameters screen.

We can now save our complete results and proceed with the Delta Compliance. The free air derived data is already in memory and we can finally deal with the last part of the procedure, which is nearly the same as before. We will be prompted for volume instead of weight. Obviously the file we have to choose is relative to the driver loaded with a known volume (15.1 liters in this case). Here we show the results for the Delta Compliance method. The two sets of data do agree pretty well.
13.4 T&S SHORTCUTS

G  Starts an T&S parameters estimation procedure.

13.5 T&S FILE TYPES

The registered file extension for T&S measurement data files is '.sml'.

T&S parameters data file.

13.6 T&S ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

T&S Parameters Data
14 LINEARITY & DISTORTION

14.1 INTRODUCTION

Linearity and Distortion analysis are grouped together though they are, apparently, opposite terms.

From the analyser point of view however, they are similar as either the fundamental or the harmonics (intermodulation) amplitude is evaluated while sweeping D.U.T. input level.

Defining applications for these analysis would bring to an endless list, limited only by user fantasy; however the entire menu is oriented to perform measurements on electronic devices as power amplifiers or preamplifiers. The X axis units can be selected between Volts and Watts. So please don’t put a microphone in front of a loudspeaker expecting useful results except, maybe, destroying the unit.

14.2 LINEARITY & DISTORTION CONTROL PANEL

Starts a Linearity and Distortion measurement.

Enters the Linearity and Distortion settings dialog box.

Compute Linearity, and is enabled only if Linearity analysis is selected (in the settings dialog, see below). Basically the process consists in dividing the measured output by the supplied input. Doing this greatly simplify realizing both DUT gain and deviation from linearity. The following example should clarify things further.
The graphs refer to a linearity measurement of a Push Pull tube amp. After processing, the Y scale can be expanded, still including the whole span, greatly enhancing detail inspection.

Input channel

Selects the input channel to measure.

14.3 LINEARITY & DISTORTION SETTINGS DIALOG

X Axis Values
Allows setting the X axis extreme left and right values. Has immediate effect, once OK is pressed, and has only graphical implication; that is it does not affect the actual or next measure span.

X Axis Unit
Can be either Volts or Watts. Has immediate effect and the curve is recalculated accordingly. Changing the impedance in the sweep settings does not affect results as the impedance set at measuring time is taken for calculation. When Vs. input is selected in the X Axis Vs., Volts is forced and the choice disabled.

X Axis Vs.
Selects if the X axis represents DUT output or input values. Input Values can only be expressed in Volts.
**Y Axis Scale**
Selects how the Y axis is displayed. When anything but **Linearity** is selected in the **Analysis** radio button panel, selecting **Volts/%** will display distortion in percent in a bi-logarithmic graph. Selecting **dB** will plot distortion in dB below fundamental/s. When **Linearity** is selected **dBV** or **Volts** will be used as Y Unit. If the compute linearity button is pressed dB or V/V are used.

**Sweep Settings**
These are all settings affecting the next measure to be performed. Must be therefore handled with care.

**Start and Stop**
Sets the voltage sweep range supplied to the DUT input. Start should be lower in value than Stop. While these values can be chosen in an iterative way, having a rough idea of the DUT gain is a good practice. Notice however that keeping the DistLim parameter to or lower than 10% would prevent hard overload of the DUT. Sweep range stops anyway when the maximum allowed distortion is reached, whatever **Stop** value is chosen. **Stop** value cannot be greater than 3V, being this the CLIO’s limit.

**Step**
Sets sweep resolution in logarithmic equal step.

**DistLim**
Sets, in percentage, the maximum allowed distortion before the sweep stop anyway.

**Imp**
In Ohm, displays the impedance used by the system to calculate power (use CLIO Options>Units Conversion to set). Should obviously be set to the real impedance that loads the DUT. Changing this value after the measurement has no effect on an already done measure; the value should be correct before the measure is taken.

**Att**
Sets the value of an eventually used passive attenuator placed on CLIO’s input. CLIO’s input accept up to 100VRMS, that is 1250W/8Ohm. Should you need more, use a resistors divider on the input and set the **Att** value accordingly. Advised values are 90-10 Ohm to divide by 10.

**Analysis**
Through this radio button control the analysis type is selected.

**Linearity**
Measures the output Voltage Vs input Voltage. Output level is measured through FFT looking only at the amplitude of the generated tone. That is harmonics noise or other is not considered in the output level.

**THD**
Measures Total Harmonic Distortion. Again distortion level is calculated via FFT and therefore noise is not taken in account. These, in some limited cases, at lower level, yields to slightly different results than those obtained via traditional THD+noise measurements. This approach is, however, more accurate. For setting the measurement frequency please see below.
Measures Intermodulation distortion using SMPTE standard. Two tones are generated in a 4:1 ratio at 60Hz and 7000Hz. Intermodulation components up to the 5\textsuperscript{th} order are considered for distortion.

**DIN**

Measures Intermodulation distortion using DIN standard. Two tones are generated in a 4:1 ratio at 250Hz and 8000Hz. Intermodulation components up to the 5\textsuperscript{th} order are considered for distortion.

**CCIF**

Measures Intermodulation distortion using two equal level near spaced (1kHz) in Frequency tones. Difference Intermodulation components up to the 2\textsuperscript{nd} order are considered for distortion. To keep results directly comparable with THD analysis both output Voltage or Power are single tone equivalent scaled. Considering a power amplifier clipping point, this usually due to the peak value of the signal rather then it RMS value. With two tone of equal level the RMS values is 3dB lower than the same peak to peak single tone.

**Freq**

Has no effect in SMPTE and DIN analysis which use fixed frequencies. Set the measurement frequency for Linearity and THD. Set the center Frequency for CCIF; for example 15500Hz means two tone are generated, spaced by 1kHz, at 15000Hz and 16000Hz.
14.4 LINEARITY & DISTORTION SHORTCUTS

G  Starts a Linearity & Distortion calculation.
S  Invokes Setting menu.

14.5 LINEARITY & DISTORTION FILE TYPES

The registered file extension for Linearity & Distortion data files is '.dst'.

Dst data file.

14.6 LINEARITY & DISTORTION ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

Distortion Data
15 ACOUSTICAL PARAMETERS

15.1 INTRODUCTION

With the Acoustical Parameters control panel it is possible to evaluate the acoustical behavior of a room and carry out sophisticated post processing of a measured impulse response to calculate the acoustical parameters as defined by the ISO 3382 standard and speech transmission index STI as defined by IEC 60268-16:2011 (fourth edition) standard.

From the Acoustical Parameters control panel it is also possible to open a direct STIPA measurement tool.

The Speech Transmission Index can be evaluated with CLIO in both indirect and direct method as defined by the IEC standard. The indirect STI calculation is a post processing of an impulse response while the direct STIPA measurement can be measured using the direct STIPA tool.

These quantities describe the behavior of auditoria, concert halls and are applicable to any room intended for speech or music reproduction.

15.2 THE ACOUSTICAL PARAMETERS CONTROL PANEL

In figure you can see the Acoustical Parameters control panel; this figure shows an octave filtered impulse response (at 1kHz) presented both as reverberant decay and ETC; then all the calculated parameters are listed in tabular form.

The source of any acoustical parameters calculation is a measured Impulse Response; CLIO gives you this possibility by means of the MLS&LogChirp menu; please refer to chapter 10 where it is described how to measure the impulse response of a room using MLS or LogChirps.

For a detailed description of the graphical display (common also to other measurement control panels) and its capabilities please refer to Chapter 6.
15.2.1 TOOLBAR BUTTONS

Starts an Acoustical Parameters calculation. See below the data source for the calculation.

Enters the Acoustical Parameters Settings dialog box.

The following three, mutually exclusive, buttons select the source of impulse response data to be processed:

**Memory.** The impulse response is already in memory and is reprocessed with current settings.

**File.** The impulse response is loaded from disk. It is possible to load the following file formats:
- **.mls** MLS&LogChirp measurement file
- **.wav** Wave file
- **.tim** MLSSA Tim file

**MLS.** Current impulse response loaded in the MLS control panel is processed.

Enters the **impulse display mode** and shows the Schroeder reverberant decay relative to the selected fraction of octave. The impulse response under processing is first octave filtered and then the Schroeder decay evaluated.

Enters the impulse display mode and shows the ETC relative to the selected fraction of octave.

Enters the **frequency display mode** and shows the selected acoustical parameter versus frequency behavior.

Selects the time instant after which the impulse response data are discarded. The parameters calculation start from this point backwards. It permits you to eliminate unwanted behaviors of the room under test and measurement artifacts.

**STI** Shows the Speech Transmission Index calculations, MTI modulation transfer function matrix, STI male and female, STIPA.

Opens a wave file and saves a processed wave file with an applied equalization filter. The filter is calculated by inverting the impulse response open in the MLS&LogChirp menu, the inversion is limited to the STI signal range as defined by the IEC 60268-16:2011 standard. Wave files and MLS&LogChirp size shall be identical.

Opens the direct STIPA measurement tool.
15.2.2 INTERACTION WITH THE A.P. CONTROL PANEL

It is possible to interact with the acoustical parameters control panel simply clicking on the parameters data table.

To enter the **impulse display mode** simply click on the table **first row** and select the desired octave band of interest; the selected column will change accordingly and the decay (or ETC) will also follow. The figure above shows the selection of the 1kHz octave to which corresponds the ETC calculated.

The **leftmost column** gives wideband parameters (Lin) calculated over the whole available bandwidth. The **rightmost column** gives wideband parameters (A) calculated applying an A-Weighting filter.

To enter the **frequency display mode** simply click on the table **first column** and select the desired parameter whose behavior versus frequency should be displayed; the selected row will change accordingly. The following figure shows the selection of the RT30 row and its behavior vs. frequency (black curve); in comparison the overlays show RT30 (green curve) and RTUser (red curve). It is not possible to select the three rows of the correlation coefficients (see below) of the calculated RT60.

<table>
<thead>
<tr>
<th>Frequency [Hz]</th>
<th>Lin</th>
<th>A</th>
<th>Lin</th>
<th>A</th>
</tr>
</thead>
<tbody>
<tr>
<td>62.5</td>
<td>2.44</td>
<td>3.06</td>
<td>1.27</td>
<td>1.68</td>
</tr>
<tr>
<td>125</td>
<td>1.54</td>
<td>2.08</td>
<td>0.87</td>
<td>1.11</td>
</tr>
<tr>
<td>250</td>
<td>0.81</td>
<td>0.95</td>
<td>0.38</td>
<td>0.49</td>
</tr>
<tr>
<td>500</td>
<td>0.80</td>
<td>0.94</td>
<td>0.38</td>
<td>0.49</td>
</tr>
<tr>
<td>1000</td>
<td>0.10</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2000</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>4000</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>8000</td>
<td>0.00</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

The selected column will change accordingly and the decay (or ETC) will also follow. The figure above shows the selection of the 1kHz octave to which corresponds the ETC calculated.

The **leftmost column** gives wideband parameters (Lin) calculated over the whole available bandwidth. The **rightmost column** gives wideband parameters (A) calculated applying an A-Weighting filter.
15.3 ACOUSTICAL PARAMETERS SETTINGS

**Frequency Bands**
Selects either Octave or Third of Octave calculations. The following figure shows the same data analyzed before in octave bands now presented with 1/3 of octave processing.

**Noise Correction**
Applies noise correction to the tail of the impulse response as suggested by ISO 3382. The figure shows the increase in the linear portion of the calculated decay which is obtainable.
It is possible to input the upper and lower level, in dB, used for RTUser calculations.

**STI Signal and Noise octave band SPL values**

The table should be filled with the measured SPL values per octave band. Table can be edited manually or .FFT files can be loaded using the [...] button at the right side of the table. FFT files should be RTA in dBSPL units and in octave bands.

**Use Signal Levels as Signal+Noise**

In cases where noise is present during the Signal Level measurement, it is possible to insert the S+N value in the table. Extrapolation of the Signal level will be managed by the software.

**Include Noise effects**

Includes the effects of the noise in the STI calculations.

**Include Masking and Threshold effects**

Includes the correction for the threshold level of hearing and the auditory masking effects.

**15.4 THE CALCULATED ACOUSTICAL PARAMETERS**

The acoustical parameters are calculated from a measured decay curve. A decay curve is defined as the decay of sound pressure level as a function of time after the sound source has ceased. The decay curves are calculated from the measured impulse response after octave filtering has been applied; also wideband (linear or A-weighted) decay curves are available.

Historically the most important acoustical parameter is the **Reverberation Time** (T or RT) defined as the time, in seconds, that would be required for the sound pressure to decrease by 60dB after the sound source has ceased; this is why the most used indication you find in literature for the reverberation time is RT60. As it is normally practically difficult to obtain a sufficient dynamic range to measure the reverberation time directly, the norm provides for its evaluation based on a smaller decay of 30dB; in this case the reverberation time, indicated as RT30, should be the time evaluated considering a linear decay given by the least-square regression of the measured curve from -5dB to -35dB. Also provided is the possibility of evaluating RT20 and RTUser (based on user defined limits).

**Sound level parameters.**

**Signal [dBSPL]**. Measured signal level in dBSPL in the band of interest.

**Noise [dBSPL]**. Measured background noise level in dBSPL in the band of interest.

**Balance between early and late arriving energy.**

**C50 [dB]**. 50ms early-to-late arriving sound energy ratio (i.e. ratio between the energy arrived in the first 50 milliseconds to the energy arrived after). C50 is usually evaluated when results relate to speech reproduction.

**C80 [dB]**. Usually named “Clarity”. 80ms early-to-late arriving sound energy ratio. C80 is usually evaluated when results relate to music reproduction.

**D50 [%]**. Usually named “Definition”. Directly relates to C50 with the following...
equation:

\[ C_{50} = 10 \log \left( \frac{D_{50}}{1 - D_{50}} \right) dB \]

**TS [ms]**. Time of centre gravity of the squared impulse response. It is another measure of acoustic clarity; the higher TS the poorer is clarity.

**Decay time measurements.**

**EDT [s]**. Early Decay Time i.e. time required to sound to decrease of 10dB from the initial maximum level. EDT is directly related to the perceived reverberation while reverberation time relates to the physical properties of the room.

**RT20 [s]**. Reverberation time evaluated from a 20 dB dynamic range (-5dB,-25dB). See also below the **correlation coefficient R** associated with RT20.

**RT30 [s]**. Reverberation time evaluated from a 30 dB dynamic range (-5dB,-35dB). See also below the **correlation coefficient R** associated with RT30.

**RTU [s]**. Reverberation time evaluated from a user defined dynamic range; refer to 15.3 acoustical parameters settings. See also below the **correlation coefficient R** associated with RTUser.

**R(RT)**. Each reverberation time estimation (RT20, RT30 and RTU) has associated a negative number which is the correlation coefficient R showing how closely the corresponding decay curve fits a straight line. A value of -1 gives a perfect linear fit. **When the correlation coefficient is smaller than -0.95 the RT value should be viewed with suspect as the decay curve may not be sufficiently linear; direct inspection of the decay curve with markers should be carried out.**
15.5 NOTES ABOUT ACOUSTICAL PARAMETERS MEASUREMENT

This paragraph gives some guidelines that should be followed while executing the measurement of the impulse response of rooms; what said here should be considered together the general procedure that is described in chapter 10 for executing MLS measurements.

**The sound source shall be as omni-directional as possible.** Maximum acceptable deviation from omni-directionality should not be higher than ±1dB up to 500Hz, ±3dB at 1kHz, ±5dB at 2kHz, ±6dB at 4kHz when excited with octave bands noise and measured in a free field.

Regarding **measurement positions** it is important to execute an adequate number of measurements with different source and receiver positions to characterize the entire room. For large auditoria a number of measurements from 6 to 10 in dependance of the number of seats (from 500 to 2000) should be carried out.

The microphone should be placed at a height of 1.2m above the floor at audience seat locations to be representative of listener's ear height.

15.6 STI CALCULATION

The Speech Transmission Index is calculated from a single measured Impulse response using the Indirect Method as described by the IEC 6026816:2011 standard.

The STI is a single number index that takes into account different effects that are decreasing the speech intelligibility in a room such as signal level, background noise and reverberation.

The vocal message is modeled as a band pass noise carrier with a sinusoidal intensity modulation. The idea is that the modulation depth is affected by the aforementioned effects which are degrading speech quality.

The STI is calculated starting from a set of MTF (modulation transfer functions) calculated for 7 octave bands and 14 modulation frequencies as defined in the IEC standard. The 7 x 14 matrix is then reduced to a vector of 7 MTI modulation transfer indexes and combined into a single number index.

In the case of the Indirect Method used by CLIO, the matrix of reduction of transfer function can be calculated from the system Impulse Response as:

\[
m(f_m) = \frac{\int_0^\infty h(t)^2 e^{-j2\pi f_m^t} dt}{\int_0^\infty h(t)^2 dt} \cdot \left[1 + 10^{-SNR/10}\right]^{-1}
\]

Some care should be followed while executing the measurement of the impulse response to be used for the STI calculation:

- the impulse length must be at least 1.6 seconds to correctly calculate the lowest modulation frequency needed for the MTF matrix
• the method is only applicable to linear, time-invariant systems
• LogChirp stimulus is preferred, distortion products shall be removed by windowing out the tail of the impulse response

The effects of the signal to noise ratio are added only if the **Include Noise Effects** option is selected, the effect of masking are added only if the **Include Masking and Threshold Effects** option is selected.

The STI memo shows the MTF modulation transfer function matrix, as calculated including the effects of noise and masking if selected.

Two STI index are calculated with a different frequency weighting, STI (male) and STI (female). If **Include Noise Effects** is selected a proper signal spectra should be played through the Public Address system or electroacoustic transducer and should be measured with an octave band RTA.

A 64k pink noise shaped with STI male spectra STILEVMALE65536.WAV is available in the CLIO distribution in the CLIO signal directory.

According to the IEC standard there are cases where the used electroacoustic transducer frequency response shall be linear in the STI frequency range. Since this is seldom the case, CLIO Acoustical Parameters has a feature (**STIPA EQ** button) which applies a predistortion to the STI shaped signal.

**STIPA index** – The STIPA index, is a simplified version of the STI calculated from a reduced set of the MTF matrix values, each noise carrier has only two modulation frequencies. Using the Indirect Method there is no real advantage in the calculation of the STIPA instead the full STI since the full MTF matrix is already available.

According to the IEC standard the (IR) suffix is appended to the STIPA name, in order to show that the STIPA is calculated from an impulse response using the
Indirect Method.

The STI is calculated together with the acoustical parameters and can be viewed in text format by pressing the STI button.

---

**MTF (with Noise + Masking)**

<table>
<thead>
<tr>
<th>Oct.Band</th>
<th>125</th>
<th>250</th>
<th>500</th>
<th>1k</th>
<th>2k</th>
<th>4k</th>
<th>8k</th>
</tr>
</thead>
<tbody>
<tr>
<td>f1=0.63</td>
<td>0.954</td>
<td>0.970</td>
<td>0.946</td>
<td>0.953</td>
<td>0.975</td>
<td>0.974</td>
<td>0.962</td>
</tr>
<tr>
<td>f2=0.80</td>
<td>0.929</td>
<td>0.958</td>
<td>0.934</td>
<td>0.942</td>
<td>0.966</td>
<td>0.966</td>
<td>0.957</td>
</tr>
<tr>
<td>f3=1.00</td>
<td>0.899</td>
<td>0.944</td>
<td>0.919</td>
<td>0.929</td>
<td>0.955</td>
<td>0.956</td>
<td>0.951</td>
</tr>
<tr>
<td>f4=1.25</td>
<td>0.830</td>
<td>0.910</td>
<td>0.882</td>
<td>0.894</td>
<td>0.929</td>
<td>0.932</td>
<td>0.936</td>
</tr>
<tr>
<td>f5=1.60</td>
<td>0.759</td>
<td>0.870</td>
<td>0.837</td>
<td>0.854</td>
<td>0.899</td>
<td>0.903</td>
<td>0.918</td>
</tr>
<tr>
<td>f6=2.00</td>
<td>0.691</td>
<td>0.828</td>
<td>0.787</td>
<td>0.810</td>
<td>0.867</td>
<td>0.873</td>
<td>0.898</td>
</tr>
<tr>
<td>f7=2.50</td>
<td>0.606</td>
<td>0.765</td>
<td>0.710</td>
<td>0.741</td>
<td>0.819</td>
<td>0.827</td>
<td>0.868</td>
</tr>
<tr>
<td>f8=3.15</td>
<td>0.535</td>
<td>0.706</td>
<td>0.636</td>
<td>0.675</td>
<td>0.773</td>
<td>0.783</td>
<td>0.837</td>
</tr>
<tr>
<td>f9=4.00</td>
<td>0.433</td>
<td>0.618</td>
<td>0.529</td>
<td>0.580</td>
<td>0.708</td>
<td>0.719</td>
<td>0.791</td>
</tr>
<tr>
<td>f10=5.00</td>
<td>0.393</td>
<td>0.535</td>
<td>0.444</td>
<td>0.517</td>
<td>0.657</td>
<td>0.665</td>
<td>0.752</td>
</tr>
<tr>
<td>f11=6.30</td>
<td>0.399</td>
<td>0.436</td>
<td>0.347</td>
<td>0.481</td>
<td>0.600</td>
<td>0.606</td>
<td>0.707</td>
</tr>
<tr>
<td>f12=8.00</td>
<td>0.384</td>
<td>0.360</td>
<td>0.236</td>
<td>0.454</td>
<td>0.539</td>
<td>0.549</td>
<td>0.659</td>
</tr>
<tr>
<td>f13=10.00</td>
<td>0.366</td>
<td>0.322</td>
<td>0.231</td>
<td>0.399</td>
<td>0.491</td>
<td>0.510</td>
<td>0.623</td>
</tr>
<tr>
<td>f14=12.50</td>
<td>0.352</td>
<td>0.273</td>
<td>0.349</td>
<td>0.365</td>
<td>0.429</td>
<td>0.478</td>
<td>0.587</td>
</tr>
</tbody>
</table>

---

**MTI**

<table>
<thead>
<tr>
<th>MTI</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.595</td>
</tr>
<tr>
<td>0.659</td>
</tr>
<tr>
<td>0.610</td>
</tr>
<tr>
<td>0.652</td>
</tr>
<tr>
<td>0.717</td>
</tr>
<tr>
<td>0.724</td>
</tr>
<tr>
<td>0.758</td>
</tr>
</tbody>
</table>

---

**Signal Leq**

| Signal Leq | 67.2 | 64.1 | 56.5 | 51.0 | 50.5 | 47.4 | 45.4 |

**Noise Leq**

| Noise Leq | 40.8 | 43.2 | 41.8 | 36.0 | 31.8 | 29.3 | 30.5 |

**STI Male**=0.69 rated B

**STI Female**=0.70 rated B

**STIPA (IR)**=0.68 rated B

The **STI** is divided in qualification bands:

![STI Qualification Bands](image-url)
15.7 DIRECT STIPA MEASUREMENT TOOL

This tool allows to measure the STIPA index with the **direct method**, instead of post-processing an impulse response, the tool acquires the signal from CLIO input A and recover the intensity modulation of each carrier/modulation combination of the STIPA signal.

The **STIPA signal is downloadable** from Audiomatica's web site selecting:

Help > On Line Resources Download

from CLIO Main Menu.

This signal should be fed to the system under test and the response measured with CLIO. The CLIO STIPA signal is compliant with the IEC standard\(^1\). The CLIO STIPA measurement tool can be used with any signal which complies with the standard.

The output signal level can be set interactively using the CLIO multi-meter, RTA or level meter tools, prior to the STIPA measurement.

Usage of the STIPA measurement tool is straightforward, while the STIPA signal is played by the system under test, just press the Go button. The measurement automatically stops after the timed stop duration is reached. The measurement can be also stopped manually using the Stop button. Default value for the integration time is 20 seconds\(^2\).

The STIPA value, together with the IEC rating value, is shown during the measurement. The equivalent signal level in dBSPL, and the MTF values are also shown in tabular form during the measurement.

If selected, the Enable Correction checkbox includes masking and threshold effects in the MTF calculation.

---

\(^1\) The STIPA signal is composed of the sum of 7 pink noise half-octave width carriers each intensity modulated with two sinusoidal modulations at the frequencies defined by the IEC standard with modulation index 0.55 and 180 degrees phase relationship.

\(^2\) The integration time should be always left to 20 seconds which, according to the IEC standard and our tests, is the time needed to the STIPA index to settle. There are though cases where the background noise is not constant where a longer or shorter integration time can be useful. Variable background noise can heavily affect STIPA calculations, users should be aware that in case of highly variable background noise using the STI indirect method is advisable.
There are 6 memory slots on the right side of the form tool. Each memory cell can be stored by clicking on cell’s number and selected for the calculation using the adjacent check-boxes. Calculated average and standard deviation values are shown.

Purge Data button clears all the memories.

Auto store checkbox automatically store measurements in memories.
15.8 A.P. SHORTCUTS

G  Starts an Acoustical Parameters calculation.

S  Invokes Setting menu.

15.9 A.P. FILE TYPES

The registered file extension for Acoustical Parameters data files is '.acp'.

Acp data file.

15.10 A.P. ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

Acoustical Parameters Data

STI Data
16 Leq LEVEL ANALYSIS

16.1 INTRODUCTION

With the Leq Analysis control panel it is possible to execute real-time capture and level measurement of any kind of signal present at CLIO’s input. The behavior of the instrument closely resemble that of a graphical level recorder plus direct-to-disk data capture.

When analyzing an acoustical event this control panel gives you complete information about the equivalent continuous sound level (Leq) and related quantities according to IEC 61672 standard; if used together the FFT frequency analysis you get a complete integrating sound level meter.

16.2 THE Leq CONTROL PANEL

![Leq control panel](image)

*Fig. 16.1 The Leq control panel*

In Fig. 16.1 you can see the Leq Analysis control panel; this figure shows a low frequency signal, increased in 2dB steps each maintained for 6 seconds, used for subwoofers power handling capability. To be noted the equivalent level Leq (black curve), the time history (red curve), the peak level (blue curve) and the levels with slow and fast integration (purple and green curves).
16.2.1 TOOLBAR BUTTONS AND CONTROLS

- Starts a Leq acquisition and analysis. If data capture is active the event is automatically registered on the hard disk.

- Invokes an FFT measurement together the Leq one.

- Enters the Leq Analysis Settings dialog box.

- When pressed, resets peak value. Does not affect any other calculation.

- Activates real time data display; useful for high resolution time measurements (1/100s and 1/1000s).

channel display

Selects the input channel to measure.

Y scale units

Selects the measurement unit.

Note:
- dBRel (with respect to the global reference level; see chapter 8)
- dBSPL, dBPa (for acoustical measurements)
- dBmeter, dBm/s (for laser measurements)
- dBm/s² (for acceleration measurements)
- dBampere (for current measurements)

Stop Hours, Minutes and Seconds

Inputs the measurement stop time. It is possible to select up to 23h59m59s measurement time.
16.2.2 INTERACTION WITH THE Leq CONTROL PANEL

It is possible to interact with the Leq control panel clicking on the left data display where you can find five three state checkboxes.

Each checkbox refers to one calculation and data curve. Its state can be:
- **Deselected**. The data value and corresponding curve are **NOT** displayed.
- **Selected**. The data value and corresponding curve are displayed with their color.
- **Active**. The data value and corresponding curve are displayed in black and curve values are inspectable with the A and B markers.

In the following figure you may see the same measurement presented in figure 16.1; we have done the following; the fast, slow and time history levels have been deselected, i.e. hidden, the peak level is now active (black curve) and inspected with the two markers while the Leq is simply visible (orange curve and value).

Below the five calculated data value you can see the actual time display which changes during measurement or, at the end, states the total duration of it.
16.3 Leq SETTINGS

Time resolution
Selects the time resolution of the measurement. It is possible to choose a value among 1s, 1/2s, 1/4s, 1/10s, 1/100s and 1/1000s. Normally choose the least resolution possible as this choice directly reflects on the measured data size (.leq binary files). This setting is not influencing the sampling frequency that remains 48000Hz.

Frequency weighting
Selects the frequency weighting applied; you can choose either No Weight or A-Weighting.

Peak mode
Selects how the peak is measured. You may select between the two:
- Max. The peak is the maximum value acquired given the particular time resolution and frequency weighting.
- LUser. The peak is the maximum value of the LUser measurement.

LUser integration
Selects the time integration of the user definable level measurement. You may choose among the following:
- No. No integration is applied; the result is that the classical time history is displayed.
- Impulse. Classical Impulse integration, 35ms time constant with 2.9dB/s decay rate.
- 35ms. Modified impulse integration; only 35ms time constant.

NOTE:
During the measurement the acquired time data is saved to the hard disk. It is then possible to create a standard wave file of the event measured for later post processing. Be extremely careful when activating this feature as it requires a huge amount of disk space: circa 6MB/min or 0.35GB/hour. Maximum recordable time is 12 hours.
16.4 Leq SHORTCUTS

G  Starts an Leq measurement.
T  Stops current measurement.
S  Invokes Setting menu.
P  Resets peak reading.
R  Enters real time data display.

16.5 Leq FILE TYPES

The registered file extension for Leq measurement data files is '.leq'.

Leq data file.

When saving a Leq measurement it is also possible to save the captured audio to a standard wave file selecting the extension .wav.

16.6 Leq ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

Time History Data
17 WOW AND FLUTTER

17.1 INTRODUCTION

Within this menu Wow & Flutter measurements are possible, meeting both IEC and NAB standards. Basically, what is measured is the frequency modulation that follows instantaneous speed variations due to mechanical imperfections in analog recording or playback devices. Differently than in traditional Wow & Flutter analyser the whole measuring process is taken digitally without relying on analog FM discriminator, filter and detector with much higher accuracy, limited by the clock quartz only. Furthermore, aside traditional number data, a time graph is presented as well as a Frequency Domain Analysis of the demodulated signal. The latter feature greatly simplify locating the cause of problems, once rotating speed and mechanical circumference of eventually defective rotating parts are known. Carrier frequency can range form 1500Hz to 6000Hz. This is important if you record directly the test signal. Using existing test support, IEC specify a test frequency of 3150Hz, NAB of 3000Hz.

17.2 WOW & FLUTTER CONTROL PANEL

Figure 17.1

17.2.1 TOOLBAR BUTTONS

▶ Starts a Wow & Flutter analysis.

◆ Stops the measurement.

▲ Enables weighting filter in the time domain windows. Frequency Domain remains unaffected. Works both when the analysis is running or as a post process.

⇌ Switch to Time Domain.

🗑 Switch to Frequency Domain.
Selects the input channel to measure.

17.3 FEATURES

Aside a self explaining graphical part, on the left part several numeric data are present simultaneously. From top to bottom they are:

**IEC LIN**
expressed in percentage, express the WOW & FLUTTER value, unweighted, following IEC standard.

**IEC WEIGHT**
expressed in percentage, express the WOW & FLUTTER value, weighted, following IEC standard.

**NAB LIN**
expressed in percentage, express the WOW & FLUTTER value, unweighted, following NAB standard.
NAB WEIGHT
expressed in percentage, express the WOW & FLUTTER value, weighted, following NAB standard.

AVG Freq
expressed in Hertz is the frequency of the carrier tone. Is a direct indication of a static speed error.

![Figure 17.3](image)

In the above figure the weighting filter response is displayed. This apply both to IEC and NAB standards. Aside carrier Frequency the main difference between them is the detector that evaluate the demodulated signal, which is peak detection in IEC and RMS in NAB; IEC Wow & Flutter values are usually greater.
17.4 WOW & FLUTTER SHORTCUTS

G  Starts a Wow & Flutter measurement.
T  Stops current measurement.

17.5 WOW & FLUTTER FILE TYPES

The registered file extension for Wow & Flutter measurement data files is '.waf'.

Wow & Flutter data file.

17.6 WOW & FLUTTER ASCII TEXT EXPORT

The following data can be exported in ASCII files (see chapter 5):

Wow&Flutter Data
18 TIME-FREQUENCY ANALYSIS

18.1 INTRODUCTION

The Time-Frequency Analysis tool allows to post-process impulse responses or recorded waveforms, and to create waterfall or color map plots of the energy of the signal versus time and frequency.

There are three Time-Frequency distributions available:
- CSD (Cumulative Spectral Decay)
- ETF (Energy Time Frequency)
- Wavelet (Wavelet Analysis)

Time-Frequency Analysis can use as data source:
- Impulse Response .mls measured with MLS&LogChirp.
- Wave audio file .wav. The file should be mono, either 16 or 32 bits, with sample rate 48 kHz, 96 kHz or 192 kHz. Wave file length should be less or equal than 2 Msamples.
- MLSSA .tim impulse measurement.

18.2 TIME-FREQUENCY ANALYSIS CONTROL PANEL

18.2.1 TOOLBAR BUTTONS AND DROP DOWN LISTS

Starts a Time-Frequency Analysis calculation.

Analysis selection

Selects the Time-Frequency analysis:
- Wavelet
- CSD
- ETF
Enters the settings dialog.

When pressed the Time-Frequency analysis plot is displayed.

When pressed the impulse response (or signal) loaded in memory is displayed.

Loads an impulse response from disk (from .mls MLS binary, .wav wave or MLSSA .tim files).

Takes current MLS impulse response for Time-Frequency calculation.

Show time-frequency distribution as color map plot.

Show time-frequency distribution as Waterfall plot.

Activates the variable change from Time to Cycles in the Wavelet analysis.

Moves the plot up on Z axis.

 Moves the plot down on Z axis.

 Expands the plot changing its Z scale. The Z range is reduced.

 Compresses the plot changing its Z scale. The Z range is increased.

Show grid. Available only on Wavelet analysis in Colormap mode.

Enters the Marker mode. In this operating mode it is possible to inspect the single data points of each waterfall slice by clicking and dragging the mouse. Available only in case of Waterfall plot.

When in marker mode, moves the selected waterfall slice backwards. The same action is obtained with the Up-Arrow keyboard shortcut.

When in marker mode, moves the selected waterfall slice frontwards. The same action is obtained with the Down-Arrow keyboard shortcut.
18.3 CSD AND ETF MODE

CSD (Cumulative Spectral Decay) and ETF (Energy Time Frequency) time-frequency distribution are calculated as a set of FFT spectra of the impulse response. Each spectra is related to a given time scale.

The set of spectra can be plotted either in form of waterfall curves or color map plots. In both cases x-axis is the frequency, y-axis time, and z-axis (color) the level.
18.3.1 CSD AND ETF SETTINGS

**Start Frequency**
Selects the start frequency for the analysis.

**Stop Frequency**
Selects the stop frequency for the analysis.

**Smoothing**
Selects the frequency smoothing in fractions of octave from 1/12 to 1/2 of octave.

**Number of Spectra**
Selects the number of data slices to display.

**Time Shift (ms)**
Selects the time between two consecutive spectra.

**Window Rise Time (ms)**
Selects the rise time of the data selecting window. Valid only for CSD.

**Reference**
If selected the waterfall spectra will be referenced to the rearmost one.
18.4 WAVELET MODE

The Wavelet mode is similar to the CSD and ETF analysis described before, but since it is based on Wavelet Transform instead of Fourier Transform, does not suffer from the inherent fixed time-frequency resolution.

18.4.1 WAVELET SETTINGS

Start Frequency
Selects the start frequency for the analysis.

Stop Frequency
Selects the stop frequency for the analysis.

Wavelet Q
Selects the time-frequency resolution for the analysis (Q>=1). Use low Q values for better time resolution and high Q values for better frequency resolution.

Wavelet No
Selects the number of wavelet scales used for the analysis. Lower numbers can be used to speed up the calculation, while reducing the analysis frequency resolution.

Normalize
If selected, each frequency slice of the spectrogram will be referenced to its energy time maximum; the plot can be interpreted as the energy rise-decay of the system.

Cycles No
Selects the number of cycles to be shown on the x-axis in case of Cycle-Wavelet analysis.

Show cycles decay only
If selected only the decay of the response in Cycle-Wavelet analysis will be shown.
Time Origin
Set the time (in milliseconds) used to calculate the origin of Cycles during the variable change from Time to Cycles. Pressing the Get button acquires the Impulse Response peak as Time Origin.

Colormap
Selects the color gradient scale to be used:
CLIO Default - standard CLIO color map
Jet Colormap - red to blue color map

18.5 TIME-FREQUENCY ANALYSIS OPERATION

As already stated, the data source for a CSD or ETF waterfall is a measured impulse .mls response, a MLSSA .tim response or a .wav file.

Once you have loaded an impulse response (or signal) inside the Time-Frequency control panel you may easily inspect it, in the same way you also do with the MLS Impulse control panel (see chapter 10).

Of great importance is to select the start time and stop time of the analysis.

When time selection is carried on, the go button should be pressed to start the calculation.

At the end of the calculation the results can be viewed as waterfall plot or color map plot.

18.5.1 CSD AND ETF OPERATION

In case of CSD: start time, the Start Window value selected in the impulse response represents time zero for the waterfall; stop time, the Stop Window value selected in the impulse response represents the last processed CSD slice unless a different Time Shift has been selected.

CSD (Cumulative Spectral Decay) is intended primarily for anechoic loudspeaker evaluation; in this case only the data between the start and stop time is analyzed; each successive slice considers time data from its relative start time (the rearmost, at time zero, has start time equal to the start window of MLS) to the fixed stop time, the data being windowed by a particular time window with a smoothed rising
edge (see literature for a discussion about this). Normal values for the Window Rise Time lie within 0.1 and 0.6ms. In CSD mode, should the Time Shift value be left at zero, the routine will automatically calculate it, spacing the selected Number of Spectra in the interval defined by start and stop times; if Time Shift is forced by the user be sure to set it small enough to permit the last spectra to be calculated; if the fixed stop time is passed, then the calculation defaults as in case of zero Time Shift.

When representing a CSD the program automatically hides the low frequency part of the spectra that has become unreliable due to the time-frequency uncertainty principle.

ETF (Energy Time Frequency) is intended for room acoustic evaluation; in this case all MLS data starting from the start time are computed; then, successive slices are calculated moving their initial point of the Time Shift value.

18.5.2 WAVELET OPERATION

The Wavelet transform of loaded impulse response or waveform signal is computed for the whole length of the impulse (signal) using the a rectangular windowing, according to the time gating settings selected on the impulse response view (i.e. start time and stop time).

Please note that this behavior is different from CSD and ETF where post-processing takes place only on the selected part of the impulse.

The Wavelet Analysis tool implemented in CLIO uses a kernel of modified complex Morlet wavelets (which are gaussian shaped sine bursts) and can be interpreted as a constant Q analysis. Time resolution is high at high frequencies and frequency resolution is not too rough at low frequencies. This kind of analysis is particularly suited for the inspection of wideband non stationary signals as the impulse responses of loudspeakers and rooms.

As a result of the Wavelet Analysis post-processing tool a matrix of coefficients is calculated. The magnitude squared of the coefficients is directly proportional to the energy of the signal in a domain located around a certain time and frequency. The magnitude squared of the Wavelet coefficients is depicted into a color plot called Scalogram.

![Wavelet Analysis](image)

The color map plot feature time on x-axis, frequency on y-axis and level on z-axis (color). Please note that the view is rotated by 90 degrees respect to the color map.

18 TIME-FREQUENCY ANALYSIS
plots of the CSD and ETF. This reflects the fact that the Wavelet coefficient are calculated in “frequency slices” while the CSD and ETF which are naturally calculated in “time slices”.

The same data can be remapped to get the same aspect of the other waterfall plots:

![Wavelet Analysis](image)

In the color map and waterfall wavelet plots the time range is the same of the impulse view. If a different zoom is needed, please go back to the impulse view, zoom and get back to the wavelet plot.

### 18.5.3 CYCLE-FREQUENCY WAVELET ANALYSIS

A cycle is related to time through the frequency of the sinusoidal components in a fairly simple way:

\[ n_{cycles}(t) = \frac{t - t_0}{T} \]

where \( t \) is the time variable, \( t_0 \) is the Cycles time origin, \( T \) is the period of a wave at the analyzed frequency \( f \) (where obviously the period is the inverse of the frequency), \( n_{cycles} \) is a new variable that can be used to plot a Cycle-Frequency-Level representation of the signal.

Once in the Wavelet Analysis tool it is possible to switch to Cycle-Frequency view by pressing the Enable Cycle-Octave button.

Viewing the Wavelet Analysis in cycles can be handy when there are resonance phenomena to inspect. In Wavelet Time-Frequency analysis resonances shows up as ridges extending in time, if there are resonances at different frequencies but with similar Q the different time length of the ridges can hide the effects of each resonance.

With Cycle-Frequency view resonances with the same Q at different frequencies retain the same length on the visualization.

The following two figures shows the wavelet analysis of a system with 4 resonances with same Q and spread over 6 octaves.
The resonances appear with the same length if the time axis variable is changed to cycles:
18.6 TIME FREQUENCY SHORTCUTS

G  Starts a Time Frequency processing.

S  Invokes Setting menu.

18.7 TIME FREQUENCY FILE TYPES

The registered file extension for Time Frequency measurement data files is '.tfa'.

Tfa data file.

Also supported are old file types:

OLD Waterfall data file.

OLD Wavelet data file.


